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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons Help icon to access help in the application. If you don't see any help icons on your page, click your user
image or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Overview

Overview of Transactional Business Intelligence  
You use Oracle Transactional Business Intelligence (OTBI) to analyze your business and take action with embedded and
ad-hoc analysis of your transactional data.

Key metrics and attributes of your business and organization are organized into subject areas of data you use as
building blocks to answer your business questions.

• Use embedded analyses and reports to gain insights and report on key business metrics

• Build ad-hoc analyses, reports, and dashboards.

• Create business intelligence (BI) catalog folders and define who has access to what in the catalog.

• Organize your analytics in dashboards and embed them in your work areas.

Architecture
OTBI integrates with Application Development Framework (ADF) to run your real-time analysis of your business subject
areas.

The BI Server creates physical queries based on metadata mappings between the subject areas you work with in your
analysis and ADF view objects and their underlying database tables. The BI Presentation Server compiles and formats
the results in the BI client or as embedded analytics.

Here's the OTBI architecture. 

1
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BI Objects and Tools
Here are some of the OTBI components and the objects they support.

Catalog Object Description BI Component or Tool

Analysis
 

Analyses are a selection of data displayed in
one or more views, such as a table or chart, to
provide answers to business questions.
 

Analytics Answers
 

Dashboard
 

Dashboards organize analytical content
and catalog objects, and present them in a
meaningful way.
 

Dashboard Builder
 

Dashboard Prompt
 

Dashboard prompts allow users to filter
dashboard content by selecting from provided
values.
 

Analytics Answers and Dashboard Builder
 

Filter
 

Filters limit the results that are displayed when
an analysis is run.
 

Analytics Publisher
 

Agent
 

Agents deliver scheduled analytics and other
content and notifications.
 

BI Delivers
 

Report
 

Reports present data in pixel-perfect printable
format for distribution.
 

Analytics Publisher
 

Data Model
 

Data models define the data source for reports.
 

Analytics Publisher
 

Subtemplate
 

Subtemplates are reusable formatting
definitions for reports.
 

RTF or XSL editor
 

Note:  You can't change privileges for the BI components, for example by changing which roles are assigned to access
Dashboards or Analytics Publisher. Any changes made to privileges in the BI Administration page Manage Privileges
page aren't preserved during any upgrade.

The catalog stores the BI objects in a folder structure of individual files, organized by product family.

BI objects and reports are organized in a folder hierarchy:

• Shared folders (parent)

• Product family, for example, Financials

• Product, for(example, Payables

• Report groups, for example, Invoices

• Dashboard reports

• Data models

• Report components

2
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• Analytics Publisher reports

• Prompts

Some Oracle Transactional Business Intelligence components aren't available in Oracle Applications Cloud:

• BI Server: Processes user requests and queries in underlying data sources.

• Catalog Manager: Manages BI catalog and objects.

• BI Administration Tool: Manages metadata repository that defines the logical structure and physical data
sources for analytic subject areas.

Related Topics
• More About Oracle Transactional Business Intelligence Components

• Queries and Performance

More About Oracle Transactional Business Intelligence
Components  
If you want to know more about Oracle Transactional Business Intelligence components, here's what we have.

Oracle Transactional Business Intelligence
Here's the information about the parts of Oracle Transactional Business Intelligence (OTBI) that support analysis against
your transactional data.

• Create and work with analyses, dashboards, and advanced analytical content, including dashboard prompts,
conditions, actions, and key performance indicators.
Creating Analyses and Dashboards in Oracle Transactional Business Intelligence

• Administer analyses, dashboards, and other content.
Administering Oracle Transactional Business Intelligence

Oracle Analytics Publisher
Analytics Publisher is the part of OTBI you use for reports.

• Run and view reports.
Using Oracle Analytics Publisher in Oracle Transactional Business Intelligence

• Create and edit reports, data models, layouts, templates, subtemplates.
Designing Pixel-Perfect Reports in Oracle Transactional Business Intelligence

• Administer Analytics Publisher, set up data sources and delivery destinations, manage security, and move
catalog objects.
Administering Oracle Analytics Publisher in Oracle Transactional Business Intelligence

3
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View Analytics, Reports, and Dashboards  

Watch video
 

There are different ways to view and work with your analytics and reports. You can view analyses, dashboards, and
reports in the course of your work, on your usual pages and infolets. Or you can find them in the business intelligence
catalog with the Reports and Analytics work area and the Reports and Analytics panel tab.

View Analytics in Infolets
Use your favorite infolet pages to find analytics.

1. Use the page controls and Previous and Next icons to explore infolet pages in the home page, where they may
appear in infolets with summaries and aggregations or performance metrics. You may also find infolets in some
work areas.

2. Click an infolet to open a detailed analysis. So for example, if an infolet has transactions summed to a total, click
it to view details of the underlying transactions.

3. Click Done.

View Objects in Familiar Work Areas and Pages
Use analyses, dashboards, and reports available in your usual pages and work areas.

1. Explore your pages. Some may include analysis and report links or embedded objects, sometimes in tabs or
panel tabs.

2. Some work areas have a Reports and Analytics panel tab, where you explore catalog folders for relevant
analyses and reports for the work area. And if you have permission, you can map more objects to the work area
if they're appropriate.

a. Open the panel tab.
b. Expand the Shared Reports and Analytics folder and explore the available content.
c. Click the link for any object and see its type to determine whether it's an analysis, a report, or a

dashboard.
d. Click View to open the object.

View Objects in the Reports and Analytics Work Area
Use the Reports and Analytics work area to search or browse the catalog and view any analysis, dashboard, or report
you have access to. It opens at the highest level of the catalog's folder hierarchy with all objects you have marked as
favorites.

Here are some things you can do in the Reports and Analytics work area.

1. Click Navigator > Tools > Reports and Analytics.

4
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2. Filter and search for objects:

a. From the Filter list, select what you want to find.
b. To view objects you have marked as favorites, select Favorites in the list. Or select Recent Items to view

objects you recently worked with, or a recent search to run it again. Enter a name or part of a name and
click the Search icon.

c. In the search results, use the icons to identify what the objects are.
d. Click the name of an object to open it, or click More and select an action.

3. In the breadcrumbs, browse the catalog folders for analytics and reports. Click any Hierarchical Selector icon
to select a different node for the next level in the hierarchy.

4. Mark objects as favorites.

◦ Select Favorites in the Saved Searches to display your favorite objects.

◦ Click the Add Favorites icon for an object to mark it as a favorite.

◦ Click the Remove from Favorites icon to remove an object from your favorites.

5. Create and edit analyses and reports.

a. Click Create and select Report or Analysis.
b. Use wizards to create your analysis or report.

6. Click the Browse Catalog button (or click the More icon for a specific report, dashboard, or analysis) to use
more features.

View Analyses
An analysis queries against your company's data and answers business questions with visualizations, such as charts
and tables. They may appear on your pages, or as parts of a dashboard.

1. From the catalog folders or search results, open an analysis to view.
2. Click Refresh to rerun the analysis and refresh its data.
3. Click Print and select either Printable PDF or Printable HTML to open a printable version.
4. Click Export to get analysis data in various formats, for example PDF, Excel, PowerPoint, comma-separated

value (CSV), and XML.

Note:  When you export data in a CSV format, dates are exported in raw format and converted to UTC time
zone.

View Grouped Analyses in Dashboards
Some analyses are grouped in dashboards to give you meaningful related information. A dashboard contains pages of
analyses, prompts that filter information, and other objects.

1. From the catalog folders or search results, open a dashboard to view.
2. Select values for any dashboard prompts to filter the dashboard.
3. Click Apply to refine the results of all of the analyses in the dashboard.

View Reports
Reports show data in a predefined format that's optimized for printing.

1. From the catalog folders or search results, open a report.

5
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2. Click the View Report icon if you want a different format.

◦ Choose HTML or PDF to display the report in a format for printing. Because it's optimized for printing,
PDF often provides the best results.

◦ You can also export the report as RTF for editing in a word processor, or as Excel or PowerPoint.

3. From the catalog folders or search results, you can also do these tasks:

◦ Click Edit to edit the report properties, layout, and data model.

◦ Click Report History to see details about past submissions of the report.

◦ Click Schedule to schedule the report to be run.

How You Use the Analytics Page  
The Analytics page shows up to five of your favorite analyses for easy access. To add an analytic to your page, mark it as
a favorite in the panel tab.

• The Analytics page is available only for some product families. See the Analyze and Report page for these cloud
services in the Oracle Help Center (http://docs.oracle.com).

◦ CX Sales

See: CX Sales Reports and Analytics

◦ Human Capital Management

See: Global Human Resources Reports and Analytics

• On these Help Center pages, you can review lists of predefined analytics that you might be able to add to your
Analytics page. You can also find guides and other resources for using and creating analytics and reports.

6
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2  Introduction to Financial Reporting

Overview of Creating Financial Analytics and Reports  
Oracle Financials Cloud provides predefined analyses, dashboards, and reports that help you meet financial and
business intelligence requirements. With the many reporting tools, you can run, view, and build user-defined or real-
time analytics and reports.

The Oracle Financials Cloud: Creating Analytics and Reports Guide covers creating and editing analysis and reports as
well as subject areas for the following Oracle Fusion Financial Applications:

• General Ledger

• Intercompany

• Budgetary Control

• Subledger Accounting

• Payables

• Payments

• Cash Management

• Expense Reporting

• Assets

• Receivables

• Collections

Configuring Analytics and Reports
You can create and edit analytics and reports for your own use. Or, if you have the appropriate roles, you can configure
for others. For example, you can:

• Add or remove columns from an analysis.

• Change the branding logo on report output.

• Create a dashboard to include your most commonly viewed analyses.

Setup and Administration
Additional tasks support creating and editing analytics and reports. For example, your implementor or administrator
can:

• Secure access to user-defined analytics and reports.

• Archive and move user-defined analytics and reports from one environment to another.

• Create financial report definitions.

7
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Overview of Financial Reporting Center  
The Financial Reporting Center is intended to be the primary user interface for financials end users to access all seven
report types.

Financial Reporting Center
The Financial Reporting Center includes these report types: Financial Reporting Web Studio Reports, Account Groups
and Sunburst, Smart View Reports, Oracle Transactional Business Intelligence Analyses, Oracle Transactional Business
Intelligence Dashboards, Oracle Analytics Publisher Reports, and Business Intelligence Mobile Apps. Other reporting
tools are also available to run the same seven report types.

This figure illustrates the report types that are available in the Financial Reporting Center.

Reports can be accessed through various methods. However, the Financial Reporting Center provides access to every
type of report, is intended to be the primary user interface for financials end users, and is tablet and smartphone
friendly. In addition to accessing reports, you can add favorites, define tags, and view report details, such as type and
last updated date.

Financial Reports are read from the Shared > Custom > Financials and My Folders directories. All other report types
can be saved anywhere in the BI Catalog however, any user-defined content should be in the Shared > Custom folder.
Subfolders can be created within the Shared > Custom folder.

8
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Seven types of reports can be run from the Financial Reporting Center and from the other reporting tools.

• Financial Reports: These reports are built off of the Oracle Financial Reporting Web Studio using data in the
Oracle Fusion General Ledger balances cube. For example, company income statements and balance sheets.
These reports are mainly run by users in General Ledger.

• Account Groups and Sunburst: Account groups are used to monitor key accounts in General Ledger. When
a user creates an account group, it becomes visible in the Financial Reporting Center with the Sunburst
visualization tool. The Sunburst visualization tool lets you interact with your account balances across various
business dimensions to view balances from different perspectives. Account groups are used only in General
Ledger.

• Smart View Reports: Smart View is a multidimensional pivot analysis tool combined with full Excel functionality.
Smart View enables you to interactively analyze your balances and define reports using a familiar spreadsheet
environment. These queries are mainly for users in General Ledger. To share Smart View queries, users can
email them to other users, or they can upload the queries to the Financial Reporting Center where users can
download them to a local drive for use. The Financial Reporting Center is only a place for users to upload and
download Smart View queries.

Note:  To upload a Smart View report to the Financial Reporting Center: select the Open Workspace for
Financial Reports task, navigate to the BI Catalog, and select Upload from the Tasks section. Be sure to
upload the Excel file to one of the folder locations mentioned previously.

• Oracle Transactional Business Intelligence Analyses: These analyses and reports are built off of transactional
tables using subject areas. These reports can be run by users in General Ledger, Payables, Receivables, Cash
Management, Intercompany, and so on.

• Oracle Transactional Business Intelligence Dashboards: Dashboards put all the information, functions,
and actions that a business user must have to do their job in one place. Dashboards are built off of Oracle
Transactional Business Intelligence objects like analyses and reports. These reports can be run by users in
General Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.

• Oracle Analytics Publisher Reports: Most of these reports are predefined and must first be submitted and
resubmitted to see the latest data by the Oracle Enterprise Scheduler through the Scheduled Processes
navigation. These reports can be run by users in General Ledger, Payables, Receivables, Cash Management,
Intercompany, and so on.

• BI Mobile Apps: Oracle Business Intelligence Mobile App Designer is an application that enables you to create
multitouch information-driven applications with rich interaction, rich visualization, and rich media, for mobile
devices such as iPhone, iPad, Android phone, tablet, and more. These reports can be run by users in General
Ledger, Payables, Receivables, Cash Management, Intercompany, and so on.

Other Reporting Tools
Six other tools are available for reporting in Financials.

The following table lists the other reporting tools and the types of reports they support.

Other Reporting Tools Report Type

General Accounting Dashboard and
Account Inspector
 

Account Groups
 

Reports and Analytics
 

Oracle Transactional Business Intelligence Objects
 

9
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Other Reporting Tools Report Type

BI Catalog
 

All Report Types, Except Oracle Analytics Pubsliher Reports
 

Enterprise Performance Management
Workspace
 

Reports, Books, Snapshot Reports, Snapshot Books, Financial Reporting Batches, and Batch Scheduler
 

Enterprise Scheduler System
 

Oracle Analytics Publisher Reports
 

Even though the Financial Reporting Center is designed to be the main user interface for a financial end user's reporting
needs, some users may choose to use any of the six other tools for reporting in financials, such as:

• General Accounting Dashboard, which provides access to Account Groups: Uses the Account Monitor to
efficiently monitor and track key account balances in real time.

• Account Inspector: Perform ad hoc queries from account groups and financial reports through drill down to
underlying journals and subledger transactions.

• Reports and Analytics: This reporting tool has a panel that reflects the folder structure of the BI Catalog. Users
can access and run any Oracle Transactional Business Intelligence analysis, report or dashboard. Users can't
run predefined Financial Reports or Oracle Analytics Publisher reports from this interface. This interface can be
used by all financials users.

• BI Catalog: A component of the Enterprise Performance Management Workspace where you can run all report
types, except for predefined Oracle Analytics Publisher reports.

• Enterprise Performance Management Workspace: Create reports, books, snapshot reports, snapshot books,
Financial Reporting batches, and batch scheduler, and schedule batches to automatically run and burst to
email.

• Enterprise Scheduler System: Only Oracle Analytics Publisher reports can be submitted from this interface.
Users access this interface by navigating to Tools > Scheduled Processes. Most financial users have access to
this interface to run standard reports for General Ledger, Payables, Receivables, and so on.

Related Topics
• Set Up Financial Reporting Center and Smart View

Overview of Reports and Analytics Tools  
The following are additional Oracle Fusion Financial reporting and analysis products:

• Oracle Analytics Publisher

• Oracle Transactional Business Intelligence

• Oracle Business Intelligence Analytics

• Spreadsheet Integration

10
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Oracle Analytics Publisher
Oracle Analytics Publisher provides the ability to create and format high-quality reports across Oracle Fusion
Applications in general, including Oracle Fusion General Ledger. It applies templates, designed by your users in familiar
desktop tools, to standard extracts and reports.

• Report layouts using familiar desktop tools, such as Adobe Acrobat PDF, Word, and Excel

• Ability to create one template to provide reports in many languages

• Reports published in various outputs such as Word, Excel, PDF, RTF, and HTML

• Scheduled reports for delivery to a wide range of destinations

Oracle Transactional Business Intelligence
Oracle Transactional Business Intelligence (Transaction BI) is a reporting tool that provides embedded analytics.
Transaction BI supports online inquiry for most transactions, reducing the requirement to build and maintain user-
defined reports. Transaction BI also provides:

• Drag-and-drop functionality to build the report layout, and immediately run the report to obtain real time
results

• Shared queries and reports using the Report Catalog, a reporting option used to view or save specific
definitions

Oracle Business Intelligence Analytics
Oracle Business Intelligence Analytics in Oracle Fusion:

• Supports real time, queries from an Oracle Fusion balances cubes and external data warehouses

• Contains prebuilt key performance indicators (KPIs) and metrics that deliver information throughout all levels of
the organization

• Preaggregates data to summarize information across multiple data sources for faster queries

Spreadsheet Integration
You can transfer data easily and promptly to spreadsheets throughout Oracle Fusion General Ledger and Oracle Fusion
Financials. In addition use the spreadsheet features in Financial Reporting, Smart View, and Business Intelligence.
Watch for the XLS icon on the toolbar associated with a tabulation of data. Selection of the icon creates a spreadsheet
tab with the displayed information.

Oracle Fusion Financials facilitates importing data by using prepared spreadsheet templates that include validation and
control features.

CAUTION:  When working with these spreadsheets, changes are not recorded in Oracle Fusion Applications until
the spreadsheet is uploaded. The upload appropriately fails unless users follow the conventions, statuses, search
requirements, refresh requirements, and other instructions associated with the spreadsheet.

Related Topics
• Guidelines for Using Desktop Integrated Excel Workbooks

11
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Financials Reports and Analytics Pane  
The Reports and Analytics pane, also called BI Composer, is a central place to quickly view or run analytics and reports
used in your work.

If you have the permission, you can:

• Create or edit reports and other analytic content by selecting subject areas, columns, filters, and prompts.

• Add reports from the business intelligence (BI) catalog to the pane.

• Find this pane in a panel tab. Navigate to: Tools > Reports and Analytics to open the Reports and Analytics work
area. The pane appears as the Contents pane.

What's In the Pane?
This table describes what's in the Reports and Analytics pane's top-level folders.

Folder Content

My Folders
 

Any user-defined analytics or reports that you saved for your own use only.
 

Shared Folders
 

• Any predefined analytics and reports that are relevant to your work area. Or, in the Reports and
Analytics work area, all the analytics and reports that you have access to.

• Any shared user-defined reports and analytics in the user-defined subfolder. Place your shared
reports and analytics in this folder to protect them during upgrades.

Business Intelligence Catalog
The business intelligence catalog stores all analytics, reports, and other BI objects. Each analysis, dashboard, or report
in the Reports and Analytics pane represents a mapping, or link, to the same object in the catalog. The Reports and
Analytics pane also reflects the folder structure of the BI catalog.

12
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3  Analyses, Reports, and Dashboards
Modification

Get Started with Oracle Transactional Business
Intelligence (OTBI) for Financials  
In this example, you view an analysis called the Payables Aging Summary. This analysis was created using Oracle
Transactional Business Intelligence, an ad hoc reporting tool. You can use the tool to create analyses, dashboards, and
infolets using information from your Oracle Financials Cloud

Viewing an Analysis
1. Let's start from the Financial Reporting Center and search for the Payables Aging Summary.
2. Click the Expand icon to see details like type and location.

In this example, the type is Analysis. The location shows you where the analysis is stored.
3. Click the title.

Now you can see the analysis. The information here is real time and based on the latest transaction
information.This analysis has bars and a table that show totals by aging categories like Current, Overdue 21 - 60
days, and so on. You can use different views like time series lines, bars, tables, and heat maps in your analyses.
An analysis can use more than one type of view to help arrange information in a way that's useful for your
audience.

4. Click the Overdue 91-180 Days bar.

A table shows the invoices that make up the total for this category. You can see invoice details like supplier
name, invoice due date, invoice number, and unpaid amount.

5. Click the Buckets drop-down list to change categories.

Now you see the details that make up another aging total.
6. Go back to the previous page.
7. Click the Analysis icon after the title.
8. Click the Edit link to open the layout.

You can make changes here and save them in the same location, or you can save them in another area that you
have access to. You can also create another analysis. Just click the New menu to get started.

13
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Overview of Oracle Analytics Publisher Best Practices for
SaaS Environments  
Oracle Analytics Publisher is an enterprise reporting solution for creating highly formatted, pixel perfect reports. It
offers a single solution environment to author, manage, and deliver a variety of business documents. Oracle Analytics
Publisher is available to customers with Oracle BI Suite Plus

Often the reports process large amounts of data, which requires product teams and end customers to understand
the best practices of Oracle Analytics Publisher. This white paper provides a detailed list of best practices that are
recommended by Oracle when using Oracle Analytics Publisher in a Software-as-a-Service (SaaS) environment. For
more information, see Oracle BI Publisher Best Practices for SaaS Environments document ID 2145444.1 on My Oracle
Support at https://support.oracle.com.

Example of Exploring Financial Subject Areas in Oracle
Transactional Business Intelligence  
In this example, you examine Financial subject areas in Oracle Transactional Business Intelligence. Here's the list
of Financial products with subject areas: Assets, Budgetary Control, Cash Management, Expenses, General Ledger,
Intercompany, Payables, Receivables, Revenue Management, and Subledger Accounting.

1. Start from the Financial Reporting Center.
2. Click Tasks.
3. Click Open Workspace for Financial Reports.
4. Select Navigate > Applications > BI Catalog.
5. You have to create an analysis to see the subject areas you have access to:

a. Click the New icon.
b. Click Analysis.

Subject areas are organized in folders and the information they contain varies based upon reporting
requirements. General Ledger subject areas cover account balances, journals, and period statuses.

6. Select the General Ledger Transactional Balances - Real Time subject area. The term Real Time in the
subject area name indicates the information is up-to-date as of the latest general ledger journal posting. You
can use this subject area to create trial balances and general queries to review changes in account balances
over time. Here are some of the folders that appear in the Subject Area pane.

◦ Balancing Segment

◦ Cost Center Segment

◦ Currency

◦ Time

◦ Ledger

◦ Ledger Set
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You can expand folders to see their components. For example, the Time folder contains accounting period and
year. If you have more than one ledger, you can create an analysis that filters by ledger and ledger set. You can
query a specific general ledger balance, or groups of general ledger balances.

7. Click the Add or Remove Subject Areas  icon in the Subject Areas toolbar to view more subject areas and the
type of information they hold.

For example, with the Payables subject areas you can examine information about suppliers, supplier balances,
and invoices, including freight and tax charges. You can also see how invoices and payments affect the general
ledger. An analysis can show which invoices were paid on time and whether checks have cleared.

The Receivables subject areas include customer information, customer balances, and invoice details such
as terms and receipts, credit memos, and revenue adjustments. Similar to Payables, you could analyze how
receipts affect general ledger account balances.

Analyses and Dashboards  

How Data Is Structured for Analytics  
The business intelligence (BI) repository contains the metadata that defines which columns you can include in analyses,
and the source of that data. The repository is organized into subject areas, which contain folders with the columns.

Note:  You can also use the BI repository as a data source for reports.

Columns
This table describes the three types of columns available when you create or edit analyses.

Column Type Description Example

Fact
 

Provides a measure of something, meaning
that the values are numbers.
 

Total
 

Attribute
 

Represents a piece of information about a
business object, with values that are dates, IDs,
 or text.
 

Note:
Attribute columns can be flexfield segments
imported into the BI repository.
 

Start Date
 

Hierarchy
 

Holds data values that are organized in a
hierarchical manner.
 

Time, with sublevels:
 

• Year

• Quarter
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Column Type Description Example

• Month

Subject Areas
When you create an analysis, you first select a subject area, which contains columns related to a specific business object
or area. Then, open folders within the subject area to find the columns to include.

For product families that use Application Composer, you can create custom subject areas to accommodate custom
objects or to add new facts for analysis.

Folders
Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders.

• Fact folders:

◦ Contain fact columns.

◦ Are usually the last in a list of folders and are usually named after the subject area.

• Dimension folders:

◦ Contain attribute and hierarchical columns.

◦ Are joined to the fact folder within a subject area.

For example, if your analysis has the Currency attribute from a dimension folder, you see currencies in
the results. If you also add the Total fact, then your analysis includes only records with both a currency
and a total amount. The more columns you add, the smaller the query set for your analysis.

◦ Can be common folders, or common dimensions, that appear in more than one subject area.

If your analysis has columns from multiple subject areas, then you:

- Should include columns only from dimension folders that are common to all of those subject areas.
At least one such column is required.

- Must include one column from the fact folder in each of those subject areas.

Related Topics
• Create and Edit Analyses Using a Wizard

• Create and Modify Analyses and Dashboards

• Manage Analytics with Advanced Features

• About Custom Subject Areas

Create and Edit Analyses Using a Wizard  
Use the wizards to quickly create and edit your analyses. You can use a wizard to create and edit most of your analytics,
for example to select columns, add filters or views.
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You can also use advanced business intelligence features to create or edit dashboards or manage analyses and other
objects in the catalog.

1. Start the wizard from the Reports and Analytics work area or the Reports and Analytics panel tab (if available).

◦ To create a new analysis click Create and select Analysis. Select a subject area for your analysis and click
theContinue button.

◦ To edit an existing analysis, in the Reports and Analytics work area, select it in a folder or the favorites list,
click its ellipsis icon and select Edit. In the Reports and Analytics panel tab, click the analysis, then click
Edit.

2. In the Select Columns page, optionally, click Add/Remove Subject Areas and, in the Add/Remove Subject
Areas dialog box, select more subject areas or remove any that you no longer need, and click OK. You can't
remove the original subject area selected for the analysis. To remove any other subject area, first remove its
columns from the analysis.

3. From here on, make selections in a series of analysis-definition pages, selecting Next or Back to navigate
among them.

◦ In the Select Columns page, expand your subject area and folders within it to choose the columns to
include in your analysis. Also set options for those columns.

◦ In the Select Views page, determine whether your analysis is to include a table, a graph, or both. For
either, select among several types. If you include both, select the order in which they appear.

◦ In Edit Table and Edit Graph pages, select options that apply to your table and graph layouts. Each of
these pages is active only if you selected the item it applies to in the Select Views page.

◦ In the Sort and Filter page, optionally apply filters to columns to refine the selection of records in your
analysis, and apply sorts to them to order your results.

◦ In the Highlight page, optionally add color highlights based on numeric thresholds you set.

◦ In the Save page, enter a name for the analysis, select a catalog folder to save it in, and click Submit.

In general, these pages are designed so that procedures for using them are readily apparent. Even so, here are some
things you will want to know.

Select Columns Page
For each column in your analysis, you select an Interaction option.

• Two of the options, Default and Drill, do the same thing: If you click on a column header, the analysis adds a
column displaying values at the next hierarchical level. (For example, if you click on Control Name, the analysis
adds a Control ID column.) If you click on a column value, the analysis adds the subordinate column, but also
filters to display only records containing the value you clicked.

• Navigate to Transaction: If you click on a value from a column for which this option is set, the analysis presents
a link to the record of an object the value applies to.

For such links to work, however, further configuration is required: You need to define paths to the records
that are to be opened. If you want to use this option, you're probably better off creating the analysis in the BI
Catalog. However, you can create it in the wizard, then edit it in the BI Catalog. See the topic titled Link Analyses
to Application Pages.

• None: This option in effect turns the Default option off and turns nothing on. Nothing happens if you click on a
value in a column for which this option is set.

For each column, you can also select a Hidden option. This prevents the analysis from displaying the column, but leaves
its values available for use behind the scenes, for example in filters.
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Select Views Page
You can add a graph to your analysis only if it includes at least one column from a fact folder. (You can include a table
in your analysis no matter what columns you select for it.) A fact column contains numeric values, such as counts of
incidents returned by advanced controls. Other columns contain attributes of objects, such as names of advanced
controls. Without numeric values, there's nothing to base a graph on.

You can create a title for the analysis in this page, but doing so is optional. You also create a name for the analysis in the
Save page, and that one is required. If you create both, the analysis displays both; they don't have to be the same.

You can use a Preview option to ensure the analysis returns data you expect. Turn it on or off in this page or in
subsequent wizard pages. Once it's on, the preview remains on in other wizard pages you navigate to, unless you turn it
off.

Edit Table Page
Here are the layout options you can select for tables:

• Columns: This is the default. Each column you assign this value to appears as a column in the table.

• Prompt For: In a prompt field, you select among values from the column you're configuring. For example, you
would select a date if the column were Calendar Month Start Date. The table would then display only rows
containing the value you selected.

• Section By: The table is divided into sections. Each value of the column you're configuring becomes a header,
and the section beneath each header includes rows containing that value.

• Excluded: The column you select is no longer available to the view you're configuring. The column is hidden,
and its values are unavailable for behind-the-scenes tasks such as filtering. However, the column remains
available to other views in your analysis.

Edit Graph Page
You can't apply layout options to fact columns. For other columns, graph layout options include Prompt For, Section By,
and Excluded, which have the same effect as they do in tables. You can also apply these options in graphs:

• Vary Color By: Each value in the column you're configuring is represented by a distinct color in the graph.

• Group By: Values in the columns you assign this option to are combined in the graph. For example, if you select
this option for the State and Calendar Month Start Date columns in a bar graph, each bar represents a particular
status on a particular date.

Highlight Page
You can use this feature only if your analysis includes at least one fact column, and you can apply it only to fact
columns.

Related Topics
• View Analytics, Reports, and Dashboards

• Where to Save Analytics and Reports

• How Data Is Structured for Analytics

• Manage Analytics with Advanced Features
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Create and Edit a Financial Analysis Using a Wizard  
You can use a wizard that guides you through creating and editing analyses. Even though the wizard doesn't give you all
available features, you can still use it to make typical changes, for example, adding views and filters.

Note:  The wizard isn't available for dashboards and you can't use it to delete analyses.

Creating an Analysis

1. Navigator > Tools: Reports and Analytics.
2. Click Create and select Analysis.
3. Select a subject area that you want to analyze, for example, the General Ledger - Journals Real Time subject

area.
4. Select the columns to include:

◦ Journal Batches: Batch Details: Journal Batch

◦ Journal Headers: Header Details: Journal Header Description

◦ Journal Lines: Line Details: Line

◦ Journal Lines:
- Accounted Debit
- Accounted Credit

◦ Time: Accounting Period Name
5. Set the following options:

◦ Interaction: Default

◦ Hidden: Leave unchecked
6. Click Next
7. Enter a title of Journal Report to appear at the beginning of the analysis.
8. Select the type of table and click Next.

Tip:  At any point after this step, you can click Submit to go to the last step, to save your analysis.

9. Enter the name of your analysis By Cost Center and select the My Folder.
10. Click Submit.

Editing an Analysis

1. Navigator > Tools: Reports and Analytics.
2. Select your analysis By Cost Center in the pane and click Edit.
3. Add Posting Status: Posting Status Meaning.
4. Click Submit: Save your analysis with the same name in the same folder.

Tip:  You can create a copy of the analysis, whether you edited it or not, just by saving it either with a new
name or in a new folder.
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Financials Data Structure for Analytics  
The BI repository contains metadata that defines which columns (or slices of data) are available to be included in
analyses. The repository also shows where the data for each column comes from. The repository is organized into
subject areas which contain folders with columns.

Columns
The following table describes the three types of columns.

Column Type Description Example Icon for Column Type

Fact
 

Provides a measure of values that
are numbers.
 

Credit Amount on Journal Line
 

Ruler
 

Attribute
 

Represents information about a
business object with values that
are dates, IDs, or text. Attribute
columns can be flexfield segments
imported into the BI repository.
 

Approval Status Code on a journal
entry.
 

Piece of paper
 

Hierarchy
 

Holds data values that are
organized in a hierarchical manner.
 

Accounting Period
 

• Year

• Quarter

• Month

Column: Hierarchy of squares
 
Sublevel: Single square
 

Subject Areas

When you create an analysis, you:

• First select a subject area which contains columns related to a specific business object or business area. For
example, General Ledger - Balances Real Time.

• Then open folders within the subject area to find the columns to include in your analysis. For example, you can
open the Approval Status folder and select the columns within it.

Folders

Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders. For example, the
Journal Lines folder in General Ledger - Journals Real Time subject area has multiple subfolders like Account, Line
Details, and Lines.

The definitions of Fact and Dimension folders are:

• Fact: A measure or metric. A fact consists of numbers. A report more often than not contains at least one fact
and not more than a few facts.
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• Dimension: Provides the context for the fact. A dimension is descriptive.

Note:  Facts and dimensions make up the report columns.

• Fact folders:

◦ Contain fact columns.

◦ Are usually last in the list of folders and are usually named after the subject area.

• Dimension folders:

◦ Contain attribute and hierarchical columns.

◦ Are joined to the fact folder within a subject area.

For example, if your analysis has Currency attribute from a dimension folder, you see currencies in the
results. If you also add the Total fact, then your analysis includes only records with both a currency and a
total amount. The more columns you add, the smaller the query set for your analysis becomes.

◦ Can be common folders or common dimensions that appear in more than one subject area. If your
analysis has columns from multiple subject areas then you:

- Must include columns only from dimension folders that are common to all those subject areas. At
least one such column is required.

- Must include one column from the fact folder in each of those subject areas.

Note:  For more information, see Financials Cloud OTBI Release 11: Subject Area Document
on Customer Connect.at:https://appsconnect.oracle.com/files/8164acf4e9/
FINS_OTBI_Subject_Area_Documentation_R_11_FINAL.pdf

Related Topics

Copy the Payables Invoice Audit Listing Dashboard  
This example shows how to copy a predefined dashboard so that you can edit the copy and not the original. If you have
appropriate roles, then you can (only if necessary) create dashboards or edit predefined ones directly. If not, then you
must

The following table summarizes key decisions for this scenario.

Decisions to Consider In This Example

Which predefined dashboard are you
copying?
 

Payables Invoice Audit Listing
 

Is the copied version for yourself only or
for multiple users?
 

Multiple users
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To copy the dashboard and get it working:

• Make a copy of the Payables Invoice Audit Listing dashboard.

• Copy the components of the dashboard, the analysis and prompt.

• Edit the copied dashboard so that it contains the copied analysis and prompt instead of the predefined ones.

Save your copies under Shared Folders > Custom in the business intelligence (BI) catalog. You must create folders
within Custom so that the copies have a folder path similar to the originals.

Copying the Dashboard
1. Open the Reports and Analytics work area.
2. In the Contents pane, select Shared Folders > Financials > Payables > Invoices > Payables Invoice Audit

Listing > Invoice Audit Listing, and click the More link.
3. With the Payables Invoice Audit Listing dashboard selected in the Folders pane, click the Copy button on the

toolbar.
4. In the Folders pane, select Shared Folders > Custom > Financials.
5. On the toolbar, click the New button and select Folder.
6. Enter Payables in the Name field and click OK.
7. Create an Invoices subfolder within the new Payables folder.
8. Click Paste on the toolbar to copy the dashboard into the Invoices folder.

Copying the Prompt and Analysis
1. With the Invoices folder still open, click New on the toolbar and select Folder.
2. Enter Prompts in the Name field and click OK.
3. Create another folder with the name Report Components. (In this context, report refers to the dashboard.)
4. In the Folders pane, select Shared Folders > Financials > Payables > Invoices > Prompts.
5. For the Payables Invoice Audit Listing dashboard prompt, click the More link and select Copy.
6. In the Folders pane, select Shared Folders > Custom > Financials > Payables > Invoices > Prompts, and click

Paste on the toolbar.
7. In the Folders pane, select Shared Folders > Financials > Payables > Invoices > Report Components.
8. For the Payables Invoice Audit Listing analysis, click the More link and select Copy.
9. In the Folders pane, select Shared Folders > Custom > Financials > Payables > Invoices > Report

Components, and click Paste on the toolbar.

Editing the Copied Dashboard
1. In the Folders pane, select Shared Folders > Custom > Financials > Payables > Invoices > Payables Invoice

Audit Listing.
2. Click the Edit link for the Invoice Audit Listing dashboard.
3. Click the Delete button for the Payables Invoice Audit Listing dashboard prompt within the Search region.
4. In the Catalog pane, select Shared Folders > Custom > Financials > Payables > Invoices > Prompts >

Payables Invoice Audit Listing and move it into the Search region.
5. Delete the Payables Invoice Audit Listing compound view within the Section 1 region.
6. In the Catalog pane, select Shared Folders > Custom > Financials > Payables > Invoices > Report

Components > Payables Invoice Audit Listing and move it into the Section 1 region.
7. Click Save.

Related Topics
• Create and Edit Dashboards
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Reports  

How Data Is Structured for Analytics  
The business intelligence (BI) repository contains the metadata that defines which columns you can include in analyses,
and the source of that data. The repository is organized into subject areas, which contain folders with the columns.

Note:  You can also use the BI repository as a data source for reports.

Columns
This table describes the three types of columns available when you create or edit analyses.

Column Type Description Example

Fact
 

Provides a measure of something, meaning
that the values are numbers.
 

Total
 

Attribute
 

Represents a piece of information about a
business object, with values that are dates, IDs,
 or text.
 

Note:
Attribute columns can be flexfield segments
imported into the BI repository.
 

Start Date
 

Hierarchy
 

Holds data values that are organized in a
hierarchical manner.
 

Time, with sublevels:
 

• Year

• Quarter

• Month

Subject Areas
When you create an analysis, you first select a subject area, which contains columns related to a specific business object
or area. Then, open folders within the subject area to find the columns to include.

For product families that use Application Composer, you can create custom subject areas to accommodate custom
objects or to add new facts for analysis.
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Folders
Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders.

• Fact folders:

◦ Contain fact columns.

◦ Are usually the last in a list of folders and are usually named after the subject area.

• Dimension folders:

◦ Contain attribute and hierarchical columns.

◦ Are joined to the fact folder within a subject area.

For example, if your analysis has the Currency attribute from a dimension folder, you see currencies in
the results. If you also add the Total fact, then your analysis includes only records with both a currency
and a total amount. The more columns you add, the smaller the query set for your analysis.

◦ Can be common folders, or common dimensions, that appear in more than one subject area.

If your analysis has columns from multiple subject areas, then you:

- Should include columns only from dimension folders that are common to all of those subject areas.
At least one such column is required.

- Must include one column from the fact folder in each of those subject areas.

Related Topics
• Create and Edit Analyses Using a Wizard

• Create and Modify Analyses and Dashboards

• Manage Analytics with Advanced Features

• About Custom Subject Areas

Create and Edit Analyses Using a Wizard  
Use the wizards to quickly create and edit your analyses. You can use a wizard to create and edit most of your analytics,
for example to select columns, add filters or views.

You can also use advanced business intelligence features to create or edit dashboards or manage analyses and other
objects in the catalog.

1. Start the wizard from the Reports and Analytics work area or the Reports and Analytics panel tab (if available).

◦ To create a new analysis click Create and select Analysis. Select a subject area for your analysis and click
theContinue button.

◦ To edit an existing analysis, in the Reports and Analytics work area, select it in a folder or the favorites list,
click its ellipsis icon and select Edit. In the Reports and Analytics panel tab, click the analysis, then click
Edit.

2. In the Select Columns page, optionally, click Add/Remove Subject Areas and, in the Add/Remove Subject
Areas dialog box, select more subject areas or remove any that you no longer need, and click OK. You can't
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remove the original subject area selected for the analysis. To remove any other subject area, first remove its
columns from the analysis.

3. From here on, make selections in a series of analysis-definition pages, selecting Next or Back to navigate
among them.

◦ In the Select Columns page, expand your subject area and folders within it to choose the columns to
include in your analysis. Also set options for those columns.

◦ In the Select Views page, determine whether your analysis is to include a table, a graph, or both. For
either, select among several types. If you include both, select the order in which they appear.

◦ In Edit Table and Edit Graph pages, select options that apply to your table and graph layouts. Each of
these pages is active only if you selected the item it applies to in the Select Views page.

◦ In the Sort and Filter page, optionally apply filters to columns to refine the selection of records in your
analysis, and apply sorts to them to order your results.

◦ In the Highlight page, optionally add color highlights based on numeric thresholds you set.

◦ In the Save page, enter a name for the analysis, select a catalog folder to save it in, and click Submit.

In general, these pages are designed so that procedures for using them are readily apparent. Even so, here are some
things you will want to know.

Select Columns Page
For each column in your analysis, you select an Interaction option.

• Two of the options, Default and Drill, do the same thing: If you click on a column header, the analysis adds a
column displaying values at the next hierarchical level. (For example, if you click on Control Name, the analysis
adds a Control ID column.) If you click on a column value, the analysis adds the subordinate column, but also
filters to display only records containing the value you clicked.

• Navigate to Transaction: If you click on a value from a column for which this option is set, the analysis presents
a link to the record of an object the value applies to.
For such links to work, however, further configuration is required: You need to define paths to the records
that are to be opened. If you want to use this option, you're probably better off creating the analysis in the BI
Catalog. However, you can create it in the wizard, then edit it in the BI Catalog. See the topic titled Link Analyses
to Application Pages.

• None: This option in effect turns the Default option off and turns nothing on. Nothing happens if you click on a
value in a column for which this option is set.

For each column, you can also select a Hidden option. This prevents the analysis from displaying the column, but leaves
its values available for use behind the scenes, for example in filters.

Select Views Page
You can add a graph to your analysis only if it includes at least one column from a fact folder. (You can include a table
in your analysis no matter what columns you select for it.) A fact column contains numeric values, such as counts of
incidents returned by advanced controls. Other columns contain attributes of objects, such as names of advanced
controls. Without numeric values, there's nothing to base a graph on.

You can create a title for the analysis in this page, but doing so is optional. You also create a name for the analysis in the
Save page, and that one is required. If you create both, the analysis displays both; they don't have to be the same.

You can use a Preview option to ensure the analysis returns data you expect. Turn it on or off in this page or in
subsequent wizard pages. Once it's on, the preview remains on in other wizard pages you navigate to, unless you turn it
off.
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Edit Table Page
Here are the layout options you can select for tables:

• Columns: This is the default. Each column you assign this value to appears as a column in the table.

• Prompt For: In a prompt field, you select among values from the column you're configuring. For example, you
would select a date if the column were Calendar Month Start Date. The table would then display only rows
containing the value you selected.

• Section By: The table is divided into sections. Each value of the column you're configuring becomes a header,
and the section beneath each header includes rows containing that value.

• Excluded: The column you select is no longer available to the view you're configuring. The column is hidden,
and its values are unavailable for behind-the-scenes tasks such as filtering. However, the column remains
available to other views in your analysis.

Edit Graph Page
You can't apply layout options to fact columns. For other columns, graph layout options include Prompt For, Section By,
and Excluded, which have the same effect as they do in tables. You can also apply these options in graphs:

• Vary Color By: Each value in the column you're configuring is represented by a distinct color in the graph.

• Group By: Values in the columns you assign this option to are combined in the graph. For example, if you select
this option for the State and Calendar Month Start Date columns in a bar graph, each bar represents a particular
status on a particular date.

Highlight Page
You can use this feature only if your analysis includes at least one fact column, and you can apply it only to fact
columns.

Related Topics
• View Analytics, Reports, and Dashboards

• Where to Save Analytics and Reports

• How Data Is Structured for Analytics

• Manage Analytics with Advanced Features

Where to Save Analytics and Reports  
You save analyses, dashboards, and reports in the catalog, along with other objects like prompts and filters.

Besides the hierarchy of folders organized by product family, another important folder is Custom, found in Shared
Folders. This is where you save the analytics and reports you create or edit for others to use.

Shared Folders and the Custom Subfolder
Anyone with the correct access can get to objects stored in Shared Folders. If you have the appropriate roles, you
can save in Shared Folders so that your objects are available for other users. You should save objects in the Custom
subfolder, and use the product family subfolders to organize and publish analytics and objects for the correct audiences.
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Here are a few things to know while working with analytics in the catalog. Keep all modified analyses and reports in
the Custom folder. Directly edit predefined analytics only when it's necessary to make sure that any references to the
analysis or dashboard still work properly.

• Preserve modified predefined objects during updates, which can make changes to predefined analytics,
reports, and other objects outside the Custom folder. You might lose changes saved outside the Custom folder
during updates.

• You can easily find modified objects if they're not spread around the catalog.

• You can edit objects in the Custom folder without compromising security on the original objects.

• For predefined reports only, you can use a special Customize option to copy the report and also the folder
structure and permissions. The copy is linked to the original, so editing the copy is like directly editing the
original.

When you copy an object into the Custom folder, the copied object inherits the permission settings of the Custom
folder. An administrator can reset the permissions on the object and the folder that it's in.

Note:  When you create folders in the catalog, don't use special characters (~, !, #, $, %, ^, &, *, +, `, |, :, ", \\, <, >, ?, ,, /)
in their names.

My Folders
My Folders is your personal storage; you're the only one who can access anything that you save there. What you save
there is available in the Reports and Analytics work area, but not in My Folders in the Reports and Analytics panel tab on
any other work area. But an exception is when you create an analysis using the wizard in the Reports and Analytics work
area. If you save a wizard analysis in My Folders, it's available in any panel tab that appears in any work area.

Note:  Don't store analyses or reports in the predefined Temp folder in My Folders. That folder is used by Analytics
Publisher and purged automatically every 24 hours.

Create Folders
Create folders in Custom or My Folders.

To create folders:

1. In the catalog, navigate to the desired location of the new folder in the Folders pane.
2. In the catalog toolbar, click New, and select Folder.
3. In the New Folder dialog box, enter the folder name, and click OK.

Automatically Created Folders
If conflicts are detected during upgrade, folders named backup_nnn are automatically created in the catalog. After
reviewing and resolving any conflicts, Oracle recommends that you manually delete the backup folders from the
catalog. You can contact your help desk to request an automated removal if you have many folders to delete.

Related Topics
• What happens to modified analytics and reports when a release update is applied?
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What happens to modified analytics and reports when a
release update is applied?  
Updates don't affect the Custom folder or My Folder in the catalog, anything saved there is preserved in updates.

This includes analytics and reports you edited or created. But anything saved outside those folders, in the predefined
catalog, is preserved only if the update doesn't include doesn't include a new version of those objects.

If an update includes a new version of a predefined object that you edited outside the Custom folder, the changes you
made are saved as a new object. The new version from the update overwrites the existing predefined object. And a copy
of the existing object (with your edits) is automatically created in the same folder, with a new name that indicates it's a
new version.

If the update includes a new version of both the predefined object and a folder in its file path, the new folder name,
along with the new version of the object, overwrites the existing predefined folder and object. And a copy of the existing
folder (along with your edited object) is automatically created. The folder is renamed to indicate that it's a new version,
but your edited object isn't renamed.

If folders named backup_nnn are automatically created in the catalog due to conflicts, after reviewing and resolving any
conflicts, Oracle recommends that you manually delete the backup folders from the catalog. You can contact your help
desk to request an automated removal if you have many folders to delete.

Note:  Future updates won't affect renamed objects or anything within a renamed folder.

Configure Email Notifications  

Overview of Financials Configurable Workflow Notifications  
The Financial applications, as part of certain business flows, automatically send notifications for review or approval. For
example, when a user submits an expense report, the approvers receive an email containing the approval request.

In addition to getting notifications in email, users can also view in-app notifications, for example, by:

• Clicking the Notifications icon in the global header and opening a notification

• Going to the Worklist: Notifications and Approvals work area and opening a notification

• Clicking the In-App Notification link at the end of an email notification

Oracle Analytics Publisher reports are used for some flows to generate the notification content and format. You can
enable Analytics Publisher-based notifications, which are ready to use as delivered. The notification templates can be
easily configured to meet other specific requirements. If required, you can change the delivered template layouts and
content, to add images, change colors and styling, add or remove attributes or modify text.

This table shows the product that has configurable notifications, along with its associated feature. You can configure
only the email notifications.
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Product Feature Name Report or Notification Name Workflow Task Name

Bill Management
 

User Registrations Notifications
 

Registration Confirmation
 
New Account Registration
Confirmation
 
Account Access Revocation
Notification
 
Access Revocation Notification
 

N/A
 

This table shows the products that have configurable notifications, along with their associated features, and workflow
task names. You can configure both the email and in-app notifications for these workflow tasks.

Product Feature Name Report or Notification Name Workflow Task Name

Advanced Collections
 

Configurable Collections
Bankruptcy Workflow Notification
 

Bankruptcy Notification
 

BankruptcyApproval
 

Advanced Collections
 

Configurable Collections Activity
Management Notification
 

Collections Activity Management
 

ActivityManagement
 

Budgetary Control
 

Configurable Budgetary Control
Override Workflow Notifications
 

Budget Override Request
Notification Budget
 

OverrideNotificationFyi
 

Budgetary Control
 

Configurable Budgetary Control
Override Workflow Notifications
 

Override Taken Notification
 

OverrideNotificationFyi
 

Cash Management
 

Configurable Cash Management
Workflow Notifications
 

Bank Transfer Approval
Notification
 

BankAcctTransferRequestForAction
 

Expenses
 

Expense Report Approval
Notifications
 

Expense Report Approval
Notification
 

FinExmWorkflowExpenseApproval
 

Expenses
 

Expense Reimbursement
Notifications
 

Reimbursement Paid to Card Issuer
Notification
 
Reimbursement Paid by Check
Notification
 
Reimbursement Paid by Direct
Deposit Notification
 

FinExmReimToCardIssuerFyi
 
FinExmReimToEmpByCheckFyiFin
 
ExmReimToEmpByDepositFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Expense Report Adjusted by
Auditor Notification
 
Expense Report Rejected by
Auditor Notification
 
Pending Payment with Warnings
Notification
 

FinExmExpenseAuditFyi
 
FinExmExpenseAuditFyi
 
FinExmExpenseAuditFyi
 
FinExmReceiptManagementFyi
 
FinExmReportShortpaidReceiptIssue
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Product Feature Name Report or Notification Name Workflow Task Name

Expense Report Returned by
Auditor Notification
 
Short-Paid Report with Receipt
Issue Notification
 
Short-Paid Report with
Noncompliance Notification
 

 
FinExmReportShortpaidPolicyIssue
 

Expenses
 

Cash Advance Notifications
 

Cash Advances Approval
Notification
 

FinExmWorkflowCashAdvanceApproval
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Payment is Held Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Payment is Released Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Expense Reimbursement
Notifications
 

Reimbursement Has Been Paid to
Employer Notification
 

FinExmReimToEmpByCheckFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Mileage Adjustment Notification
 

ExpenseAuditMileageAdjustmentFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Missing Receipt Declaration is
Required Notification
 

FinExmReceiptManagementFyi
 

Expenses
 

Cash Advances Notifications
 

Overdue Cash Advance
Notification
 

FinExmWorkflowOverdueNotification
 

Expenses
 

Cash Advances Notifications
 

Cash Advances Automatically
Applied Notification
 

FinExmWorkflowCashAdvanceAutoAppliedFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Inactive Employee's Outstanding
Transactions Notification
 

FinExmInactiveEmployeeSubmitExpenseFyi
 

Expenses
 

Expense Audit and Receipt
Management Notifications
 

Inactive Employee-Accept
Responsibility Notification
 

FinExmInactiveEmployeeAcceptResp
 

General Ledger
 

Configurable Journal Workflow
Notifications
 

Journal Approval Report
 

FinGlJournalApproval
 

Intercompany
 

Configurable Intercompany
Workflow Notifications
 

Intercompany Transaction
Approval Notification
 
Intercompany Enter Receiver
Distribution Notification
 

FinFunTransactionApproval
for Intercompany Transaction
Approval Notification
 
FinFunEnterDistRequestForAction
for Intercompany Enter Receiver
Distribution Notification
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Product Feature Name Report or Notification Name Workflow Task Name

Payables
 

Configurable Invoice Approval
Email Notifications
 
Configurable Invoice Approval In-
App Notifications
 

Invoice Approval Report
 

FinApInvoiceApproval
 

Payables
 

Configurable Hold Resolution Email
Notifications
 
Configurable Hold Resolution In-
App Notifications
 

Hold Resolution Notification
 

FinApHoldApproval
 

Payables
 

Configurable Payment Approval
Email Notifications
 
Configurable Payment Approval In-
App Notifications
 

Payment Approval Notification
 

PaymentApproval
 

Payables
 

Invoice Account Coding
Notifications
 

Invoice Account Coding Email
Notification
 

FinApInvoiceAccountCoding
 

Receivables
 

Configurable Credit Memo Request
Approval Workflow Notification
 

Manual Credit Memo Request
Notification
 

FinArTrxnsCreditMemosCreationPostProcessing
 

Receivables
 

Configurable Receivables Credit
Memo Request Manual Entry
Workflow Notification
 

Credit Memo Request Manual
Entry Notification
 

FinArTrxnsCreditMemosManualEntryRequestForAction
 

Process Overview
Generating configurable notifications through Analytics Publisher involves various types of objects in the BI catalog,
including data models, subtemplates, style templates, and reports. Reports pull data from data models and generate
notifications in an HTML format. The report layout templates use common table and paragraph styles and refer to a
central subtemplate that contains reusable notification components.

This figure shows how these BI objects work together to generate the notification content.
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• Data Sources: Store the attributes and attribute values for business objects and transactions in the application
(example of data sources being transaction tables)

• Data Model: Determines which attributes from data sources are available to be included in the notification and
how that data is retrieved

• Subtemplate: Provides common components, such as a branding logo and buttons, that can be reused in
multiple reports.

• Style Template: Provides styles such as the type of lines and fonts to use in tables, or the font type, size, and
color to use for headings

• Report: Contains a layout template that determines:

◦ Which attributes appear in the notification, from the data model used for the report

◦ What the notification looks like, leveraging components from the subtemplate and styles from the style
template used for the report

• HTML: Format of the output generated by the report

• Email Notification: Has the HTML output embedded in the email body

• In-App Notification: Has the HTML output embedded in the application UI

Each workflow task with configurable notifications has a corresponding predefined report in the BI catalog. For
example, the Invoice Approval report contains the Invoice Approval Notifications report layout template and uses the
Invoice Approval Data Model.

Notification Modifications
After you enable configurable workflow notifications, the predefined reports and related objects in the BI catalog work
by default. The report-based notifications provide the same information as the standard notifications. In addition, the
format of report-based notifications is optimized for mobile devices. If you need to modify the notifications, you can
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edit copies of the predefined reports, data models, and subtemplate. However, you can't change the style template. You
proceed as you would to edit any report, data model, or subtemplate in the catalog, for example:

1. Find a predefined report for expense approval in the BI catalog.
2. Use the Customize option to create a copy, or copy the report and paste it within the Custom folder.
3. Edit the copied report layout template.

Before modifying configurable notifications, it's recommended that you familiarize yourself with Analytics Publisher in
general. This improves your ability to format your notifications to meet your business requirements.

With Analytics Publisher-based notifications you:

• Use only the Template Builder for Word add-in to edit the .rtf template in Microsoft Word, rather than the layout
editor or other tools available for creating and editing report layout.

• Edit a copy of predefined layout templates, rather than creating reports or layout templates.

Note:  For more information, see Configurable Workflow Notifications: Implementation Considerations
(2215570.1) on My Oracle Support at https://support.oracle.com.

Related Topics
• Best Practices for Workflow Notifications

• Overview of Notifications and Approval Workflows

• Example of Modifying Expenses Email Notifications Using Oracle Analytics Publisher

• Example of Modifying Invoice Approval Workflow Notifications Using Oracle Analytics Publisher

Add a Branding Logo and Change Other Shared Components in
Workflow Notifications  
A predefined subtemplate has common components for all workflow notifications based on predefined report layouts.
For example, the subtemplate has a place for you to add a branding logo, which would appear at the beginning of email
notifications.

You can change other shared components so that the same changes apply to your notifications. For example, for email
notifications, you can also change the text on action buttons, or the text of the links that appear at the end of emails.
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Note:
• Other than this central subtemplate for all notifications, you might also find predefined subtemplates specific

to a product family. We talk about the central one here, but you would generally follow the same steps for other
subtemplates.

• You must edit a copy of the subtemplate in the Custom folder of the business intelligence (BI) catalog. Don't
directly update the predefined subtemplate, including renaming it.

• When you work on your copy of the subtemplate, add your own content or edit what's already there, but don't
remove anything.

• The exact steps can vary depending on your version of Microsoft Word.

Modify Shared Components in the Subtemplate
Here's ow you edit a copy of the predefined subtemplate that has the shared components:

1. Click Navigator > Tools > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), expand Shared Folders > Common Content > Templates.
4. For Workflow Notification Subtemplate, click More and select Customize.

If you're not using the Customize option, even though it's recommended:

a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
b. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates. Create a

Templates folder in this location if it doesn't exist.
c. Click Paste in the toolbar.

5. In the BI catalog, with the Templates folder open under the Custom folder, click More for the subtemplate and
select Rename to give it a new name.

6. Click the Edit link for the renamed subtemplate.
7. In the Templates section, click the link in the Locale column.
8. Save the subtemplate .rtf file to your computer.
9. Open the .rtf file with Microsoft Word.

◦ To add a logo, insert your own image in the subtemplate.

◦ To change button or link text, edit the text accordingly. Make the same edits wherever that button or link
text appears in the subtemplate.

CAUTION:  To make sure that your layout templates reflect these changes without more rework, don't
edit any other text in the subtemplate .rtf file.

10. Update Word options so that existing links remain intact in the subtemplate.

a. Click File > Options > Advanced.
b. In the Word Options dialog box, click Web Options in the General section.
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c. In the Web Options dialog box, open the Files tab.
d. Deselect the Update links on save check box.

11. Save your changes in Word.

Upload the Modified Subtemplate
Now you upload your subtemplate to the BI catalog:

1. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates.
2. Click Edit for your subtemplate.
3. In the Templates section, click the Upload icon.
4. Select your modified .rtf subtemplate and a locale, and click OK to replace the original subtemplate.

Point Layout Templates to Your Subtemplate
Update all the report layout templates that you want to apply your subtemplate to:

1. In Microsoft Word, open the .rtf file for the layout template, as you would to make any other changes to the
notification.

2. At the beginning of the document, change the subtemplate reference. For example, change <?
import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?> to <?import:xdoxsl:///
Custom/Common Content/Templates/My Workflow Notification Subtemplate.xsb?>.

3. Save your work.
4. Test things out to make sure you see your subtemplate changes in the notification output.

Related Topics
• Best Practices for Workflow Notifications

• What is a subtemplate?

• Customize Pixel-Perfect Reports

Best Practices for Workflow Notifications  
Predefined workflow notifications based on report layout templates all follow a general format. When you edit a copy of
these templates in Microsoft Word, follow the predefined layout as closely as possible. Keep in mind shared components
and mobile considerations.

General Structure
In general, the workflow notifications contain a set of components that are displayed in a certain order.

The callouts in this figure identify the email notification components listed in the following table.
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The callouts in this figure identify the in-app notification components listed in the following table. In addition to
describing each component, the table also indicates if the component appears in the email notification, in-app
notification, or both.
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Callout Component Notification Type

1
 

Buttons with the primary actions to take on
the task, such as Approve and Reject. These
buttons aren't part of the configurable, report-
based notification content.
 

In-app
 

2
 

Notification header listing key attributes of the
workflow task and the associated transaction.
 

Both
 

3
 

Buttons for the primary actions to take on the
task, such as Approve and Reject.
 

Email
 

4
 

Notification body that usually includes
transaction and line level details, displayed in
tables or sets of attributes with corresponding
values. The data model for the report restricts
the total number of rows displayed in some
of the tables. If the limit is exceeded, the table
footer provides a link to the transaction details
page, where users can view all the rows. To
change this limit, you can edit a copy of the
data model.
 

Both
 

5
 

Approval history, including any attachments
that users in the history uploaded for the task.
You can't edit the approval history component,
which usually appears in the body of only email
notifications. For in-app notifications, you can

Email (or both, in rare cases)
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Callout Component Notification Type

usually view the history by clicking the Actions
button and selecting History.
 

6
 

Buttons for the primary actions again.
 

Email
 

7
 

A link to the corresponding transaction page,
and another link to the in-app notification.
 

Email
 

When you modify notifications, try to keep to this general structure and don't remove essential elements such as the
action buttons. Likewise, don't change the styles in your layout template. The predefined style template should still
apply to your notification; don't edit a copy of the style template and apply that to your notification.

To add components to your notification, for example another table, consider first downloading another style template
from My Oracle Support. This template contains Quick Parts content that you can use in Word when you do more
advanced work on layout templates. For example, from the Quick Parts gallery, you can select and add the table that's
consistent in format with predefined tables already on your notification.

Here are other things to consider:

• By default, the components that you add in the layout template appear in both email and in-app notifications,
where available. You can add conditions to explicitly make a particular element, for example a field, appear only
in one type of notification and not the other.

• If you don't know which data model a report is using, find the report in the BI catalog and click the Edit link.
From there, you can see the name of the data model, and also click the Select Data Model icon to see where
it's at in the catalog.

• Don't rename any predefined reports, style templates, or subtemplates.

• To go back to a predefined layout, you can select the predefined layout template as the default.

• To go back to using the predefined report or data model for notifications, you just need to remove the custom
report or data model from the Custom folder.

Shared Components
A predefined subtemplate in the business intelligence (BI) catalog applies to all predefined layout templates for
workflow notifications. The subtemplate contains components that are shared among the notifications, for example:

• Branding logo, if you add one to the subtemplate, which would appear as the first component in the email body.
The logo appears in email notifications only.

• Action buttons in email notifications.

• Links at the end of the email notification, one to the corresponding transaction page, and another to the in-app
notification.

When you make a copy of a predefined layout template to edit, the copy automatically inherits the same predefined
subtemplate. To edit these shared components, make a copy of the predefined subtemplate, edit the copied version,
and apply it to your own layout templates.
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Mobile Considerations
Because users can view the workflow notifications on mobile devices, always consider mobile first and keep the
notifications as simple as possible. For example:

• Don't put too much content horizontally, such as too many columns in tables.

• Keep all text, including attributes and column headings, as short as possible.

• Center align lists of attributes and their values, if they appear outside tables.

Make sure to test your email notifications on mobile devices.

Related Topics
• Add a Branding Logo and Change Other Shared Components in Workflow Notifications

• Use Quick Parts for Workflow Notifications

• Set Up Content to Appear in Only Email or In-App Workflow Notifications

• Create RTF Templates Using the Template Builder for Word

Preview Changes and Upload Layout Templates for Workflow
Notifications  
Before uploading .rtf files for report layout templates to the business intelligence (BI) catalog, preview the output with
your changes in Microsoft Word. You can avoid uploading a broken report that displays an error in the notifications sent
to users.

Note:  The exact steps can vary depending on your version of Microsoft Word.

Before You Start

• Generate sample report data from the data model used for the report, and save the .xml file to your computer.

• Download a local copy of the subtemplate that applies to your own report layout template:

a. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates if you're using
a modified subtemplate, or Shared Folders > Common Content > Templates for the predefined
subtemplate.

b. Click Edit for Workflow Notification Subtemplate.
c. In the Templates section, click the link in the Locale column.
d. Save the subtemplate .rtf file to your computer.

Preview Output
To generate sample output from a local layout template:

1. Open your .rtf report layout template in Microsoft Word and make your edits.
2. On the ribbon, open the Analytics Publisher tab and click Sample XML within the Load Data group.
3. Select the .xml file you downloaded to import sample data from the data model.
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4. At the beginning of your .rtf document, replace the path with the location of the downloaded subtemplate file
on your computer. For example, change <?import:xdoxsl:///Common Content/Templates/Workflow Notification
Subtemplate.xsb?> to <?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>.

5. From the Analytics Publisher tab on the ribbon, click HTML in the Preview group.
6. If the preview reflects your changes as expected, then change the path back to the original location.
7. From the Analytics Publisher tab on the ribbon, click Validate Template in the Tools group.
8. Also in the Tools group, click Check Accessibility.
9. Save your changes in Word.

Upload the Modified Layout Template
Here's how you upload your layout template to the BI catalog after previewing the changes:

1. Back in the BI catalog, click Edit for the report within the Custom folder, if that page isn't still open.
2. Click the View a list link.
3. Click the Create icon on the table toolbar.
4. In the Upload or Generate Layout section, click Upload.
5. Upload your edited .rtf file with a unique layout name.
6. Back on the page for editing the report, go back to the list view.
7. Select the Default Layout check box for your layout template. If you ever want to go back to the predefined

layout, you can select it as default later.
8. Click the Save Report icon.

Related Topics
• Best Practices for Workflow Notifications

• Test Data Models and Generate Sample Data

Use Quick Parts for Workflow Notifications  
Use the Quick Parts feature in Microsoft Word to insert reusable pieces of formatted content. When you edit copies of
predefined report layout templates for workflow notifications in Word, you can add predefined Quick Parts content to
your .rtf file.

For example, you can insert a table in a format that's consistent with predefined notifications. The predefined Quick
Parts content is available in a style template .dotx file on My Oracle Support.

Note:  The exact steps can vary depending on your version of Microsoft Word.

Prerequisites
To get the predefined Quick Parts content into your Quick Parts gallery:

1. Open Configurable Workflow Notifications: Implementation Considerations (2215570.1) on My Oracle Support at
https://support.oracle.com.

2. Download the .dotx file and save it to your Microsoft Word template folder, for example C:\Users\<user name>
\AppData\Roaming\Microsoft\Templates.

Also, to preview your layout template changes before uploading the .rtf file back to the business intelligence (BI) catalog:

• Generate sample report data from the data model for the report that you're editing.
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• Download a local copy of the subtemplate that applies to the layout template.

Adding Quick Parts Content to Workflow Notifications
To insert content from the Quick Parts gallery into a layout template:

1. In the BI catalog, find the predefined report with the layout template that you want to modify.
2. For the report, click More and select Customize.

If you're not using the Customize option:
a. Copy the predefined report and paste it in an appropriate subfolder within the Custom folder.
b. Click the Edit link for the copied report.

3. Click Edit for the layout template to insert Quick Parts content into, and save the .rtf file to your computer with
a new file name.

4. Open the .rtf file with Microsoft Word.
5. Put your cursor where you want to insert new content.
6. From the Insert tab on the ribbon, click Quick Parts within the Text group, and select the component to insert.
7. Edit the inserted component as needed and add any other components.
8. Save your changes in Word.

Previewing the Layout Template Changes
To preview your edits before uploading your layout template to the BI catalog:

1. On the ribbon, open the Analytics Publisher tab and click Sample XML within the Load Data group to import
sample data from the data model. Skip this step if you already loaded sample data.

2. At the beginning of the document, replace the path with the location of the downloaded subtemplate file on
your computer. For example, change <?import:xdoxsl:///Common Content/Templates/Workflow Notification
Subtemplate.xsb?> to <?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>.

3. From the Analytics Publisher tab on the ribbon, click HTML in the Preview group.
4. If the preview reflects your changes as expected, then change the path back to the original location.
5. Save your changes in Word.

Uploading the Modified Layout Template
To upload your layout template to the BI catalog after previewing the changes:

1. Back in the BI catalog, click Edit for the report within the Custom folder, if that page isn't still open.
2. Click the View a list link.
3. Click the Create icon on the table toolbar.
4. In the Upload or Generate Layout section, click Upload.
5. Upload your edited .rtf file with a unique layout name.
6. Back on the page for editing the report, click Delete for the layout template that you downloaded earlier.
7. Click the Save Report icon.

Related Topics
• Best Practices for Workflow Notifications

• Configurable Workflow Notifications: Implementation Considerations

• Understand Style Templates

• Test Data Models and Generate Sample Data

• Customize Pixel-Perfect Reports
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Apply Changes to Workflow Notifications Soon After Upload  
Configurable workflow notifications are refreshed every 24 hours so that they perform better for your users. But
when you're making changes to reports, subtemplates, or data models, you can apply your changes sooner so they're
available for testing.

Create profile options to control when notifications reflect your changes after you upload them to the BI catalog.
When you're done configuring notifications, use the same profile options to turn the refresh back to every 24 hours, to
optimize performance. But even if you don't, the refresh automatically resets to 24 hours when it's been more than eight
hours since you set the profile options.

Note:  The refresh applies only to changes uploaded to the BI catalog and the actual notifications that are then sent
out with your changes. You can always preview changes to layout templates while you're editing in Microsoft Word or
view the report in Oracle Analytics Publisher.

Create Profile Options to Control the Refresh
Your profile options can apply to all workflow tasks, a product family, or a product. Based on the scope you want, your
profile option must have a profile option code that follows a certain format.

Scope Profile Option Code Examples

Global
 

BIP_CLIENT_REFRESH_TIME
 

BIP_CLIENT_REFRESH_TIME
 

Product Family
 

BIP_CLIENT_REFRESH_TIME_<FAMILY>
 

• BIP_CLIENT_REFRESH_TIME_FIN

• BIP_CLIENT_REFRESH_TIME_HCM

• BIP_CLIENT_REFRESH_TIME_PRC

• BIP_CLIENT_REFRESH_TIME_PRJ

• BIP_CLIENT_REFRESH_TIME_SCM

Product
 

BIP_CLIENT_REFRESH_TIME_<FAMILY>_
<PRODUCT>
 

• BIP_CLIENT_REFRESH_TIME_FIN_AP

• BIP_CLIENT_REFRESH_TIME_HCM_PER

• BIP_CLIENT_REFRESH_TIME_PRC_PON

• BIP_CLIENT_REFRESH_TIME_PRJ_PJE

• BIP_CLIENT_REFRESH_TIME_SCM_EGO

The profile options with a smaller scope take precedence. For example, you have profile option A with a global scope
and profile option B with a product scope. If you're currently configuring notifications for a particular product, use
profile option B to adjust the refresh time just for that product. But based on profile option A, the refresh is still at 24
hours for all other configurable notifications in all other products. Profile option B takes precedence over profile option
A only for that one product.
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Tip:  To find the product family or product code, go to the Setup and Maintenance work area. Use the Manage
Taxonomy Hierarchy task in the Application Extensions functional area for any offering. In the hierarchy, expand
the root node and then the Oracle Fusion node. Find the row for the family or product and look in the Module Key
column for the code.

Now you're ready to create your profile options!

1. In the Setup and Maintenance work area, go to the Manage Applications Core Profile Options task in the
Application Extensions functional area for your offering.

2. On the Manage Applications Core Profile Options page, click the New icon.
3. On the Create Profile Option page, enter the profile option code in the format that corresponds to the scope

you want.
4. Enter a display name that you can easily remember to help you find the profile option later.
5. From the Application list, select Oracle Middleware Extensions for Applications.
6. From the Module list, select Application Core.
7. Specify a start date.
8. Click Save and Close.
9. On the Manage Applications Core Profile Options page, make sure your new profile option is selected in the

Search Results: Profile Options subsection.
10. In the <Profile Option>: Profile Option Levels subsection, select the Enabled and Updatable check boxes for

the Site level.
11. Save your work.

Set the Refresh Interval
In the Setup and Maintenance work area, go to the Manage Applications Core Administrator Profile Values task in
the Application Extensions functional area. Set your profile option at the Site level and enter 15 or higher for the refresh
interval in minutes. For example, if you enter 15, then your changes are applied to notifications 15 minutes after you
upload to the BI catalog.

CAUTION:  Make sure to enter a whole number.

When you're done making and testing your changes, set the profile option back to 1440, which is 24 hours in minutes.
If you forget and leave your profile option as is for longer than eight hours, don't worry! At that point, the profile option
resets itself back to 1440 minutes.

Related Topics
• Update Existing Setup Data

• Set Profile Option Values

• Modules in Application Taxonomy

Modify Journal Approval Notifications with Analytics Publisher  
This example shows how to modify notifications for the journal approval workflow using Oracle Analytics Publisher
reports.

The following table summarizes the key decisions for this scenario.
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Decisions to Consider In This Example

What text changes are needed in the
notification header?
 

Append the fiscal year.
 

What additional field should the
notification header include?
 

The name of the user who created the journal batch.
 

What changes are needed in the details
section of the notification?
 

Replace the values of the cost center and account segments with the descriptions for those segments.
The chart of accounts has the following segments: Company, Cost Center, Account, Product.
 

Modify the journal approval notification by:

1. Downloading the report layout template.
2. Copying and modifying the data model. This step is only needed if the attributes to be added to the notification

aren't already present in the data model.
3. Exporting the data model. You must perform this step even if you didn't make changes to the data model. This

step is needed for previewing.
4. Editing the report layout template.
5. Previewing the modified notification.
6. Uploading the modified report layout template.

For more information about configuring Anlaytics Publisher notifications, see the Reports chapter in the Creating
Analytics and Reports for Financials Cloud guide.

Prerequisites
1. To edit the report layout template, download and install Template Builder for Word, which is an extension to

Microsoft Word.
a. Sign in to the application with the application consultant job role.
b. In the Reports and Analytics work area, click the Browse Catalog button.
c. Click the Home link.
d. In the Get Started section, click the Download BI Desktop Tools link.
e. Select Template Builder for Word from the list.
f. Save the file and run the installer.

2. To preview the notification output for your modified report layout template, you must first download a copy of
the Workflow Notification Subtemplate.

a. Click the Catalog link on the Oracle Business Intelligence home page and expand the Shared Folders >
Common Content > Templates folder.

b. Click the Edit link for the Workflow Notification Subtemplate. The subtemplate page opens.
c. In the Templates section, click the language name link in the Locale column.
d. Save the subtemplate .rtf file to your computer.

3. The predefined data model displays the account combination, which is based on segment values, on the journal
approval notification. To display a combination of segment values and descriptions on the notification, identify
the segment codes for all of the chart of account segments. The segment codes are used in the task Copying
and Modifying the Data Model.

a. In the Setup and Maintenance work area, go to the following:
- Offering: Financials
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- Functional Area: Financial Reporting Structures
- Task: Manage Chart of Accounts Structure

b. Search for the Accounting Flexfield and click Manage Structures to open the Manage Key Flexfield
Structures page.

c. Search for your chart of accounts and click Edit in the Search Results section.
d. Find the segment code values for all of the segments in the Segment Code column. In this example, the

segment codes are VF_Company, VF_Cost_Center, VF_Account, and VF_Product.
4. Find an existing journal approval notification and note the values for the following attributes: accounting

period, journal batch name, and ledger name. This information is used to produce sample report data for the
task Exporting the Data Model.

Note:  The exact steps can vary depending on your version of Microsoft Word.

Downloading the Report Layout Template
The report layout template contains the structure of the notification. To download a copy of the journal approval report
layout template to your local drive for modification:

1. Sign in to the BI server (for example, http://hostname.com:7001/xmlpserver) with the application consultant job
role.

2. Click the Catalog link to open the Catalog page.
3. In the Folders pane, expand the Shared Folders > Financials > Workflow Notifications > General Ledger

folder.
4. Click the Journals folder to display the Data Models subfolder and the Journal Approval Report.
5. Click the More link for the Journal Approval Report, and then select Customize from the menu. The Journal

Approval Report folder, containing the predefined report layout template, is automatically copied to the Custom
folder and the Journal Approval Report page opens from within that folder.

Note:  If the Customize option isn't available from the menu, check that you signed in to the BI server as
mentioned in step 1.

6. Click the Edit link on the copy of the Journal Approval Notification report layout template.
7. Save the copy of the .rtf file to your local drive and change the file name to distinguish it from the predefined

report layout template. For example, save the file as UpdatedJournalApprovalNotificationReport.rtf.

CAUTION:  Be sure to change the name of the .rtf file, otherwise you could overwrite the predefined report
layout template.

Copying and Modifying the Data Model
Always make a copy of the data model to preserve the predefined data model from errors and to have a data model to
which you can revert. Modify the copy to add or remove attributes from the data model. In this example, you modify the
data model to include either a segment value or a segment description for each segment in the chart of accounts.

1. To copy the data model:

a. Click the Catalog link on the Oracle Business Intelligence home page to open the Catalog page.
b. In the Folders pane, expand the Shared Folders > Financials > Workflow Notifications > General

Ledger folder.
c. Click the Journals folder to display the Data Models subfolder and the Journal Approval Report.
d. In the Folders pane, click the Data Models subfolder to select it.
e. In the toolbar, click the Copy Resource button.
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f. In the Folders pane, expand the Shared Folders > Custom > Financials > Workflow Notifications >
General Ledger folder.

g. Click the Journals folder to select it.
h. In the toolbar click the Paste Resource button to create a copy of the Data Models folder.

Note:  The Journal Approval Report is automatically redirected to use the copy of the data model in the
Custom folder.

2. Use a text editor to construct the SQL statement for each segment in the chart of accounts to display either a
value or a description.

a. Use this statement as a template for displaying a segment value:
FUN_BIP_UTIL_PKG.get_seg_value_from_code(lines.CODE_COMBINATION_ID,'Segment_code') as Segment_Val.

Use this statement as a template for displaying a segment description:
FUN_BIP_UTIL_PKG.get_seg_description_from_code(lines.CODE_COMBINATION_ID,'Segment_Code') as

Segment_Desc

b. Replace the Segment_code value in each statement with the segment codes from your chart of accounts.
c. Replace the Segment_Val or Segment_Desc values at the end of each statement with a user-defined term for

that segment.

Note:  The user-defined terms are added to the report layout template as part of the task Editing the
Report Layout Template.

The following table shows the segment names, segment codes, and prepared SQL statements for each
segment in the chart of accounts. Each SQL statement includes the segment code and ends with the user-
defined term representing the segment and indicating whether it's a value or a description. For example, the
SQL statement for the cost center ends with CostC_Desc. Each statement ends with a comma.

Segment Name Segment Code SQL Statement

Company
 

VF_Company
 

FUN_BIP_UTIL_PKG.get_seg_value_

from_code(lines.CODE_COMBINATION_

ID,'VF_Company') as Company_

Value,

 

Cost Center
 

VF_Cost_Center
 

FUN_BIP_UTIL_PKG.get_seg_

description_from_code(lines.CODE_

COMBINATION_ID,'VF_Cost_Center')

as CostC_Desc,

 

Account
 

VF_Account
 

FUN_BIP_UTIL_PKG.get_seg_

description_from_code(lines.CODE_

COMBINATION_ID,'VF_Account') as

Account_Desc,

 

Product
 

VF_Product
 

FUN_BIP_UTIL_PKG.get_seg_value_

from_code(lines.CODE_COMBINATION_
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Segment Name Segment Code SQL Statement

ID,'VF_Product') as Product_

Value,
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3. To edit the copy of the data model:

a. Find your copy of the data model by expanding the Shared Folders > Custom > Financials > Workflow
Notifications > General Ledger > Journals > Data Models folder.

b. Click the Edit button for the Journal Approval Data Model copy. The Journal Approval Data Model page
opens.

c. In the Data Model pane, in the Data Sets folder, click the Journal Lines data set.
d. On the Diagram tab, click the Edit Selected Data Set button. The Edit Data Set - Journal Lines dialog box

opens with the SQL query for the Journal Lines data set.

The following figure shows the Edit Data Set - Journal Lines dialog box with the predefined SQL query.

e. In the SQL Query field, place your cursor after SELECT and insert rows for the new SQL statements.
f. Copy the SQL statements that you prepared in step 2 into the SQL query field after the word SELECT and

before the lines.JE_HEADER_ID HDR_ID.

The following figure shows the Edit Data Set - Journal Lines dialog box with the new SQL statements.
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g. Click OK to close the Edit Data Set - Journal Lines dialog box.
h. Click the Save button to save the modified copy of the data model.

Exporting the Data Model
To add fields from the data model to your copy of the report layout template, you must first export the modified data
model .xml file.

1. Click the Catalog link on the Oracle Business Intelligence page to open the Catalog page.
2. In the Folders pane, expand the Shared Folders > Custom > Financials > Workflow Notifications > General

Ledger > Journals folder.
3. Click the Data Models folder to display the modified Journal Approval Data Model.
4. Click the Edit link for the data model. The data model page opens on the Diagram tab.
5. Click the Data tab.
6. To export the full data model .xml file, click in each of these fields and enter values from an existing journal

approval notification: Accounting Period, Journal Batch Name and Ledger Name.
7. To include empty fields in the data model export, click the Properties link in the Data Model pane.
8. On the Properties page, select the Include Empty Tags for Null Elements option.
9. Click Save.

10. In the Data Model pane, click the Data Sets link to return to the Data tab.
11. Click the View button to view the sample data.
12. Click the Export button and save the Journal Approval Data Model .xml file to a local drive.
13. Repeat step 7 to return to the Properties page and deselect the Include Empty Tags for Null Elements option.

Note:  If you leave this option selected, performance issues could result.

14. Click Save.
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Editing the Report Layout Template
Edit the copy of the report layout that you downloaded earlier in the task Downloading the Report Layout Template.

1. To append the fiscal year to the notification header:

a. Open your local copy of the report layout template using Microsoft Word.
b. Place your cursor at the end of the default header text, which is Journal Batch Approval.
c. Add a space and enter the text Fiscal Year 2017 - 2018. The header now says Journal Batch Approval

Fiscal Year 2017 - 2018.

The following figure shows the modified notification header.
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2. To add the name of the user who created the journal batch to the notification:

a. Select the Publisher tab to open the Publisher ribbon.
b. In the Load Data group on the ribbon, click Sample XML.
c. On the XML data selection dialog box, select the .xml file that you saved in step 11 of the task Exporting

the Data Model. Click Open.
d. Click OK on the message that appears indicating that the data was successfully loaded.
e. In the header section of the report layout template, place your cursor at the end of the BATCH_SOURCE

field, and insert a new line.
f. Enter the text label for the new field, such as Batch Created By, and then add a space.

g. In the Insert group on the Publisher ribbon, click the Field button. The Field dialog box opens with a list of
the data model fields.

h. In the JOURNAL_BATCH folder, select the BATCH_CREATOR field and click Insert. The field is
automatically added to the header section after the new text label.

i. On the Field dialog box, click Close.

The following figure shows the modified notification header.
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3. To replace the account combination ID fields on the report layout template with the segment values and
descriptions that were added to the data model:

a. Place your cursor after the label called StrtLineLINE_ACCOUNTEC and insert a new line.
b. In the Insert group on the Publisher ribbon, click the Field button. The Field dialog box opens with a list of

the data model fields.
c. In the Journal Lines folder, select the COMPANY_VALUE field. The name for this field is the user-defined

name for the company segment from the task Copying and Modifying Data Model.
d. Click Insert to add the field to the report layout template.
e. In the report layout template, add a character such as a hyphen, to separate the segments.
f. Select the rest of the segments from the Field dialog box and insert them into the report layout template

with a separator between each segment.

The following figure shows the modified notification with the account segments.

g. Format the segments that were added by copying the format from the CLINE_ACCOUNTEC field in the
report layout template. Click the CLINE_ACCOUNTEC field.

h. Click the Home ribbon, select the Format Painter button, and select the segments that were added. For
example, select COMPANY_VALUE-COSTC_DESC-ACCOUNT_DESC-PRODUCT_VALUE.

i. Place your cursor after the CLINE_ACCOUNTEC field and insert a new line.
j. Copy the account line that you created in the previous steps of this section and paste it into the new line.

The following figure shows the modified notification with the account segments appearing after both the
StrtLineLINE_ACCOUNTEC and the CLINE_ACCOUNTEC fields.

k. Delete the fields StrtLineLINE_ACCOUNTEC and CLINE_ACCOUNTEC from the report layout template.
l. Click Close on the Field dialog box.
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4. Save your local copy of the report layout template.

Previewing the Modified Notification
Before uploading your modified report layout template to the BI catalog, you should preview the output with the
changes that you made. You can avoid uploading a broken report that displays an error to users.

1. Replace the path at the beginning of the modified .rtf template with the location of the subtemplate
that you downloaded as a prerequisite. For example, change <?import:xdoxsl:///Common Content/
Templates/Workflow Notification Subtemplate.xsb?> to <?import:file:///C:/Template_Directory/
FinFunWorkflowNotificationSub.rtf?>.

Note:  Save the original path information so you can copy it back after previewing.

2. In the Preview group on the Publisher ribbon, click HTML.

The following figure shows an example of how the account combination appears in the preview. The value
for the company segment is 31111. The segment description for cost center is R&D US. The description for the
account segment is White Wine Revenue, and the value for the product segment is 0000.

3. If the preview reflects your changes as expected, then change the subtemplate path in the .rtf file back to the
original location.

4. In the Tools group on the Publisher ribbon, click Validate Template.
5. Save the modified report layout template.

Uploading the Modified Report Layout Template
To use the modified report layout template for future journal approval notifications:

1. Click the Catalog link on the Oracle Business Intelligence home page to open the Catalog page.
2. In the Folders pane, expand the Shared Folders > Custom > Financials > Workflow Notifications > General

Ledger folder.
3. Select the Journals folder to display the Data Models folder and the Journal Approval Report.
4. Click the Edit link for the Journal Approval Report to open the Journal Approval Report page.
5. Click the View a list link to open the Layout page.

Tip:  The Layout page displays the copy of the predefined report layout template that was automatically
created in step 5 of the task Downloading the Report Layout Template. If you're not satisfied with your
changes, you can revert back to this copy by making it the default layout. (Refer to step 11.) Alternatively, you
can revert back to the predefined report layout template by deleting the Journal Approval Report folder from
the directory Shared Folders > Custom > Financials Workflow Notifications > General Ledger.

6. Click the Create button. A page opens with a Create Layout section and an Upload or Generate Layout section.
7. In the Upload or Generate Layout section, click the Upload button. The Upload Template File dialog box

opens.
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8. Complete the fields, as shown in this table.

Field Value

Layout Name
 

Enter a name for the modified report layout template. For example, enter Modified Journal
Approval Template.
 

Template File
 

Click Browse. Locate and select the modified report layout template that's on your local drive.
Click Open to return to the Upload Template File dialog box.
 

Type
 

RTF Template
 

Locale
 

English
 

9. Click Upload. The Journal Approval Report page returns to the thumbnail view and displays the report layout
template that you just uploaded, along with the original copy.

Note:  Configurable workflow notifications are refreshed every 24 hours so that they perform better for
your users. But when you're making changes to reports, subtemplates, or data models, you can apply your
changes immediately so they're available for testing. For more information, see the Apply Changes to
Workflow Notifications Immediately After Upload topic.

10. Click the View a list link to return to the Layout page with the list of the report layout templates.
11. In the row for the report layout template that you just uploaded, click the Default Layout option. This step

enables the modified report layout template for future journal approval notifications.
12. Click the Save button to save the change to the default layout.

Related Topics
• Overview of Oracle Analytics Publisher Best Practices for SaaS Environments

• Add a Branding Logo and Change Other Shared Components in Workflow Notifications

• Best Practices for Workflow Notifications

• Overview of Financials Configurable Workflow Notifications

• Set Up for RTF and Excel Report Layout Templates

Example of Modifying Expenses Email Notifications Using Oracle
Analytics Publisher  
This example shows you how to modify the Expense Report Approval email notification template using Oracle Analytics
Publisher templates.

Oracle Analytics Publisher

The following table summarizes questions to consider for this scenario.
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Questions to Consider This Example

Do I want to change in the header of the
email approval notification?
 

Add a word to the header.
 

Do I want to add fields or columns to or
remove fields or columns from the email
approval notification?
 

Add a field to the template.
 

You can modify an Expenses BI Publisher email approval notification by:

1. Exporting the Expense Approval Data Model
2. Downloading the Expense Report Approval template
3. Editing the Expense Report Approval template
4. Adding field and table attributes to the Expense Report Approval template
5. Previewing the modified Expense Report Approval template
6. Uploading the modified Expense Report Approval template

Prerequisites
Before you can modify an Expenses workflow email approval notification, complete these steps:

1. Download and install the Template Builder for Word, which is a BI Publisher add-on for Microsoft Word.

a. Sign into the Oracle Analytics Publisher server with the BI Administrator Role.
b. On the Oracle Analytics Publisher home page by the Get Started section, click the Download BI

Publisher Desktop Tools link.
c.

Select and install Template Builder for Word.
2. Download a copy of the subtemplate, which is the FinFunWorkflowNotificationSub.rtf file, to your local drive.

a. Click the Catalog menu.
b. In the BI Catalog, expand Shared Folders > Common Content > Templates.
c. Click the Edit link for Workflow Notification Subtemplate.
d. On the Workflow Notification Subtemplate - Sub Template page in the Templates section, click the

language name link in the Locale column.
e. Save the FinFunWorkflowNotificationSub.rtf file to your local drive.

3. Create an expense report and note the expense report number. You enter the expense report number when you
export the data model .xml file.

Exporting the Expense Approval Data Model
Before you can modify the Expense Report Approval template, you must export the .xml file that contains the
predefined data model attributes for the notifications. Complete these steps:

1. Sign into the Oracle BI Publisher server with the BI Administrator Role.
2. Navigator > Tools > Reports and Analytics.
3. On the Oracle BI Publisher home page, click the Catalog menu.
4. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Workflow Notifications.
5. Expand the Expenses folder.
6. Click the Expenses subfolder to display the data models and the notification templates.
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7. Click the Data Models link.
8. By Expense Approval Data Model, click the Edit link.

The Diagram tab displays data sets for the Expense Approval Data Model.
9. Scroll to see all the data sets.

10. To ensure that all data sets include requested elements with null values in the output XML data, complete these
steps:

a. In the Data Model pane, click the Properties link.
b. In the Properties section, select the Include Empty Tags for Null Elements check box.

11. In the Data Model pane, click the Data Sets link.
12. On the Expense Approval Data Model page, select the Data tab and scroll to locate the Expense Report

Number field.
13. In the Expense Report Number  field, enter the expense report number that you created in the third step of the

Prerequisites section in this document.
14. Click View to see the sample data and all the available attributes.
15. Click Save As Sample Data.
16. Click OK.
17. Click Export.
18. Click Save as to save the Expense Approval Data Model .xml file to your local drive.

Downloading the Expense Report Approval Template
The Expense Report Approval template contains the structure of the email approval notification. To download a copy of
the Expense Report Approval template to your local drive, complete these steps:

1. Click the Catalog menu.
2. On the Catalog page in the Folders pane, expand Shared Folders > Financials > Workflow Notifications >

Expenses.
3. Click the Expenses subfolder to display data models and the notification templates.
4. By Expense Report Approval, click the More link, and select Customize.

An image of the predefined Expense Report Approval Email Notification appears. A copy of the Expense Report
Approval template is automatically created in the Custom folder. You can find the copy by expanding Shared
Folders > Custom > Financials > Workflow Notifications > Expenses.

5. By the predefined Expense Report Approval Email Notification template, click the Edit link.
6. Click Save as to save the Expense Report Approval Email Notification template to your local drive as an .rtf file.

Tip:  Save the downloaded template with the name UpdatedExpenseApprovalNotificationReport.rtf to
distinguish it from the predefined template.

Editing the Expense Report Approval Template
To edit the header section of the Expense Report Approval Email Notification template, complete these steps:

1. Double click the UpdatedExpenseApprovalNotificationReport.rtf file you saved to your local drive.
2. In the header section, place your cursor between Expense and Approval.
3. Type Report. The text now reads Expense Report Approval.

You can add, delete, or change words in the Expense Report Approval template.
4. Save and close the .rtf file.
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Adding Field and Table Attributes to the Expense Report Approval Template
To add field and table attributes to the Expense Report Approval template, complete these steps:

1. In Microsoft Word, open your local copy of the UpdatedExpenseApprovalNotificationReport.rtf file.

Note:  Depending on your version of Microsoft Word or your installation of Template Builder for Word, you
may see either a BI Publisher tab or you may find BI Publisher by the Add-ins menu.

2. From the Add-ins menu, select BI Publisher > Data > Load Sample XML Data.
3. In the Select XML data dialog box, search for and select the Expense Approval Data Model .xml file you

downloaded.
4. Click Open.

A message displays that indicates your .xml data was successfully loaded.
5. Click OK.
6. To insert a field in the Expense Report Approval template, place your cursor at the end of the line you want to

insert into, and press the Enter key on the keyboard.
7. From the Add-ins menu, select BI Publisher > Insert > Field.
8. In the Field dialog box, scroll to the EXPENSES folder, select IMG_REQ_FLAG, and click Insert.

This step inserts text that indicates a receipt image is required. You can add fields from the data model
anywhere in the Expense Report Approval .rtf template.

9. From the Add-ins menu, select BI Publisher > Insert > Field.
10. In the Field dialog box, scroll to the RECENTSIMILAREXPENSES folder, select any field that you want to insert,

and click Insert.

Note:  You can also insert fields that are associated with the following folders: RecurringViolations,
RecentSimilarExpenses, and UnappliedCashAdvances.

11. Save and close the UpdatedExpenseApprovalNotificationReport.rtf file.

Previewing the Modified Expense Report Approval Template
Before uploading your modified Expense Report Approval template to the BI Catalog, you can preview the changes you
made. By previewing changes, you can avoid uploading a modified template that displays errors in the emails sent to
users.

1. Open your local copy of the UpdatedExpenseApprovalNotificationReport.rtf file in Microsoft Word.
2. At the beginning of your modified .rtf template, save the path information for future reference so you can

replace it after previewing. The path information may look like this: <?import:xdoxsl:///Common Content/
Templates/Workflow Notification Subtemplate.xsb?>

3. Replace the path at the beginning of your modified .rtf template with the location of the subtemplate that you
downloaded as a prerequisite. For example, change <?import:xdoxsl:///Common Content/Templates/Workflow
Notification Subtemplate.xsb?> to <?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?
>

Note:  In the preceding example, part of the replacement path, C:/Template_Directory, represents the folder
in which the user downloaded the subtemplate to in the second step of the Prerequisites section in this
document. Ensure that you change all backward slashes to forward slashes.

4. From the Add-ins menu, select BI Publisher > Preview > HTML.
5. If the preview reflects your expected changes, then change the path at the beginning of your modified .rtf file

back to the original path.
6. From the Add-ins menu, select Validate Template.
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7. Save your changes in Microsoft Word.

Uploading the Modified Expense Report Approval Template
To upload and use the modified Expense Report Approval template for email approval notifications, complete these
steps:

1. On the Oracle BI Publisher home page, click the Catalog menu.
2. On the Catalog page in the Folders pane, expand Shared Folders > Custom > Financials > Workflow

Notifications > Expenses.
3. Click the Expenses subfolder to display the data models and the notification templates.
4. By the Expense Report Approval, click Edit.
5. On the Expense Approval Report page, click Add New Layout.
6. In the Upload or Generate Layout section, click the Upload icon.
7. In the Upload Template File dialog box, Layout Name field, enter

UpdatedExpenseApprovalReportTemplate. The entry represents the name of the Expense Report Approval
Template .rtf file that you downloaded and saved to your local drive with the prefix Updated.

8. In the Template File field, browse for your modified UpdatedExpenseApprovalReportTemplate.rtf file on your
local drive, select the template, and click Open.

9. In the Upload Template File dialog box from the Type choice list, select RTF Template.
10. From the Locale choice list, select English (United States).
11. Click Upload to open the Processing dialog box and return to the Expense Approval Report page.

The uploaded modified .rtf file appears.

Note:  Configurable workflow notifications are refreshed every 24 hours so that they perform better for
your users. But when you're making changes to reports, subtemplates, or data models, you can apply your
changes immediately so they're available for testing. For more information, see the Apply Changes to
Workflow Notifications Immediately After Upload topic.

12. On the Expense Approval Report page, click the View a list link.
13. In the Layout section in the row for the Updated Expense Report Approval Template, select the Default Layout

check box. This step enables your modified Expense Report Approval Notification template to act as the default
email approval notification.

14. Click the Save Report icon.

Related Topics
• How You Modify Copies of Predefined Reports

• Set Up for RTF and Excel Report Layout Templates

Enable Expenses Configurable Email Notifications  
You can use workflow email approval notifications to submit approvals to approvers. These approval notifications are
based approval notifications that are embedded in emails.

If you want to change the content or appearance of your email approval notifications, you can modify the content or
format of the Oracle Analytics Publisher templates.

Before you can use or modify workflow email approval notifications, you must enable in Setup and Maintenance any or
all of the following sets with their corresponding notifications:

• Expense Report Approval Notifications
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◦ Expense report approval notification

• Expense Reimbursement Notifications
◦ Expense report payment notification to employee (check)

◦ Expense report payment notification to employee (direct deposit)

◦ Payment to card issuer notification

• Expense Audit and Receipt Management Notifications
◦ Expense report is rejected by auditor

◦ Expense report is returned to employee

◦ Expense report is short paid due to receipt issue

◦ Expense report is adjusted

◦ Expense report is short paid due to non-compliance issue

◦ Pending payment with warnings

• Cash Advance Notifications
◦ Cash advance approval notification

Enabling Configurable Email Notifications
To enable workflow email approval notifications, follow these steps:

1. Navigator > My Enterprise > Offerings.
2. In the Offerings work area, select Financials.
3. Click Opt In Features.
4. On the Opt In: Financials page, select Expenses.
5. Click the Edit icon.
6. On the Edit Features: Expenses page, select Configurable Expenses Email Notifications.
7. Click the Edit icon.
8. In the Feature Name: Configurable Expense Email Notifications dialog box, select any or all of the

notification sets.
9. Click Save and Close.

Configure Expense Digest
The expense digest is a notification email delivered to the user's email. A separate digest email is sent to each expense
delegate. The email includes an overview of all expenses and highlights the expenses that require the user's attention,
such as items with missing information, possible matches to corporate card charges, outstanding corporate card
charges, and so on. To do this, you need to be assigned the Corporate Card Account Administration role. You use the
options in the Expense Digest section in the Manage Auto Submission and Matching Options page to configure the
delivery of expense digest. To access this page, in the Setup and Maintenance work area, go to the following:

• Offering: Financials

• Functional Area: Expenses

• Task: Manage Auto Submission and Matching Options

Here are the different settings you can configure to set up the delivery of expense digest:
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Option Description

Schedule
 

Use this option to enable and disable the delivery of email digest. By default, this option is set to Yes.
 

Frequency
 

Specify the days of the week when the email digest is sent to the users. This option is enabled when
the Schedule option is set to Yes. Monday is the default day for sending email digests.
 

Test Notification Email Address
 

Use this field in the development and test environments to specify a test email to which email digests
are delivered. This is helpful in testing if email digests are delivered as required. This field isn't available
in the final environment.
 

Configuring Payables Workflow Notifications  
You can configure Payables workflow notifications for both email and in-app to meet your business needs and
requirements. For example, approvers for Payables invoice approval receive a standardized workflow notification when
the invoice requires their approval.

This standardized workflow notification has a list of attributes shown in a specific format. However, you have your
own requirements regarding what information is in the approval workflow notifications and in the format you
want displayed. The ability to configure Payables workflow notifications to meet your specific business needs and
requirements is now available. The capability to configure the notifications supports changing the format, content,
and display of the notifications. In the invoice workflow approval notification, you have the ability to add other invoice-
related attributes that you want to display in those workflow notifications.

Payables Workflow Notifications
The current Payables workflow notifications are listed in the following table:

Notification Name Workflow Task Name Description

Invoice Approval
 

FinApInvoiceApproval
 

Workflow notifications sent for approving
invoices.
 

Hold Resolution
 

FinApHoldApproval
 

Workflow notifications sent for resolving
invoices on hold.
 

Payment Approval
 

PaymentApproval
 

Workflow notifications sent for payment
approval of invoices.
 

Invoice Account Coding
 

FinApInvoiceAccountCoding
 

Workflow notifications sent for account coding
of invoices.
 

Note:  For the Invoice Approval and Invoice Account Coding in-app notifications, use the Edit Distributions option in
the Actions menu to edit the distributions.
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Oracle Analytics Publisher
Use Oracle Analytics Publisher for configuring the Payables workflow notifications.

• The notifications are optimized for mobile devices and are ready to use as delivered.

• The notifications are generated based on Analytics Publisher templates that are ready to use as delivered.
The templates can be easily configured to meet your business requirements. If required, you can change the
delivered template layouts and content, to add images, change colors and styling, add or remove attributes or
modify text.

• Any change made to the BIP template impacts both the email and the in-app notifications.

Predefined BIP reports generate workflow notifications pulling content from the standard data models. The
report layouts use common table and paragraph styling. In addition, a common sub template is used for
reusable notification components, including: a custom logo in the notification header, action buttons, and task
history.

Note:  The history component is currently not based on a BIP data model and can't be modified.

Note:  The same template is used for both email and in-app notifications. Any change made to the BIP
template for email has an impact on the in-app notification as well.

Best Practices
The following are recommended best practices:

• Never edit delivered notifications.

• Use the Customize feature for reports and subtemplates.

• Copy the data models, paste into the Custom folder, and edit the copies.

• Do not rename the standard BI components, the reports or sub templates. Preview your changes before
publishing. In case of errors, revert the changes.

• Do not modify any links in the subtemplate file. Before saving a local copy, disable the Update links on the save
option in Microsoft Word.

Related Topics
• Overview of Financials Configurable Workflow Notifications

• Example of Modifying Invoice Approval Workflow Notifications Using Oracle Analytics Publisher

Example of Modifying Invoice Approval Workflow Notifications
Using Oracle Analytics Publisher  
This example shows how to modify workflow notifications for the invoice approval workflow using Oracle Analytics
Publisher reports. Any modifications you make apply to both email and in-app notifications.

The following table summarizes the key decisions for this scenario:
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Decisions to Consider In This example

What text changes are needed in the
header section of the notifications?
 

Add custom text to the notification to give instructions to the approvers.
 

What additional fields should the header
section of the notification contain?
 

Add an additional attribute for displaying Payment Terms for the invoice.
 

Prerequisites

Download and install the Template Builder for Word, which is an extension to Microsoft Word.

1. In the Reports and Analytics work area, click the Browse Catalog button.
2. Click the Home link.
3. In the Get Started section, click the Download BI Desktop Tools link.
4. Select Template Builder for Word from the list.
5. Save the file and run the installer.

Modifying Invoice Approval Workflow Notification
To add the custom instructions text to the header section of the notification, we need to modify the common
subtemplate used for the notifications.
To edit a copy of the predefined subtemplate that contains the shared components:

1. Click on Navigator > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), expand Shared Folders> Common Content>Templates.
4. For Workflow Notification Subtemplate, click More and select Customize.

If you're not using the Customize option:
a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
b. In the BI catalog, expand Shared FoldersCustomCommon Content Templates. Create a Templates folder

in this location if it doesn't exist.
c. Click Paste in the toolbar.
d. Click the Edit link for the copied subtemplate.

Note:  All reports using the predefined subtemplate are automatically redirected to point to your subtemplate
in the Custom folder. This applies:

◦ To all reports, predefined or not.

◦ No matter if you copy and paste the subtemplate or use the Customize option.

◦ Only if your subtemplate has the same name and relative file path in Custom as the predefined
subtemplate

5. In the Templates section, click the link in the Locale column.
6. Save the subtemplate .rtf file to your computer.
7. Open the .rtf file with Microsoft Word.

◦ To add custom instructions text, add a new section with the following details:
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- <template:InstructionText?>
All invoices must be approved within 2 working days. In case of any queries, kindly write to
approval.support@vision.com.

◦ <?end template?>

Note:  To ensure that your layout templates reflect these changes without additional rework,
don't edit any other text in the subtemplate .rtf file.

8. Update Word options to ensure that existing links remain intact in the subtemplate

◦ Click File > Options > Advanced.

◦ In the Word Options dialog box, click Web Options in the General section.

◦ In the Web Options dialog box, open the Files tab.

◦ Deselect the Update links on save check box.

Note:  The exact steps can vary depending on your version of Microsoft Word.

9. Save your changes in Word.

Uploading the Modified Subtemplate
To upload your subtemplate to the BI catalog after previewing the changes:

1. In the BI catalog, expand Shared FoldersCustomCommon Content Templates..
2. Click Edit for Workflow Notification Subtemplate.
3. In the Templates section, click the Upload icon.
4. Select your modified .rtf subtemplate and a locale, and click OK to overwrite the original subtemplate.

Next we will make changes to the Invoice Approval Workflow Notification report layout to reflect the updates in
the shared component, as well as add the new attribute to the report layout. To do this, we need to modify the
Invoice Approval Workflow Notification report layout.

Downloading the Report Layout Template
The report layout template contains the structure of the workflow notification. To download a copy of the report layout
template to your local drive for modification:

1. Sign in to the BI server (for example, http://hostname.com:7001/xmlpserver) as an Application Implementation
Consultant to open the Oracle Analytics home page.

2. Click the Catalog link to open the Catalog page.
3. In the Folders pane, expand the Shared Folders>Financials>Workflow Notifications> Payables folder.
4. Click the Invoices folder to display the Data Models subfolder and the Invoice Approval Report.
5. Click the More link for the Invoice Approval Report, and then select Customize from the menu. The Invoice

Approval workflow Notification report layout template is automatically copied to the Custom folder. The Invoice
Approval Report page opens from within the Custom folder.

6. Click the Edit link on the copy of the Invoice Approval workflow Notification report layout.
7. Save the copy of the .rtf file to your local drive and change the file name to distinguish it from the predefined

report layout template. For example, save the file as UpdatedInvoiceApprovalNotificationReport.rtf.
Note:  Be sure to change the name of the .rtf file, otherwise you could overwrite the predefined report layout
template.
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Exporting the Data Model
To add attributes to the report layout template, you must first export the data model for the report.

1. Navigate back to the Oracle Analytics home page, and click the Catalog link.
2. On the Catalog page, in the Folders section, expand Shared Folders>Financials>Workflow

Notifications>Payables> Invoices.
3. Click the Data Models folder to display the Invoice Approval Data Model.
4. Click the Edit link for the Invoice Approval Data Model. The Invoice Approval Data Model page opens on the

Diagram tab.
5. Click the Data tab. To export the full data model, you must first enter valid values for Business Unit, Supplier

and Invoice Number attributes from an existing Invoice.
6. Click in each of these fields and enter valid values from an existing Invoice approval notification:
7. To include empty attributes in the data model export, click the Properties link in the Data Model section.
8. On the Properties page, select the Include Empty Tags for Null Elements option.
9. In the Data Model section, click the Data Sets link to return to the Data tab.

10. Click the View button to view the data model.
11. Click the Export button and save the Invoice Approval Data Model_.xml file to your local drive.

Modifying the Invoice Approval Workflow Notification Report Layout
To add a reference to the update in the subtemplate for the Instruction text that we want to add to the Invoice Approval
Workflow Notification:

1. Open your local copy of the report layout template using Microsoft Word.
2. Replace the path with the location of the modified subtemplate file on your computer. For example, change <?

import:xdoxsl:///CommonContent/Templates/Workflow Notification Subtemplate.xsb?> to <?import:file:C:///
Template_Directory/Updated Workflow Notification Subtemplate.ret?..

3. Place your cursor at the end of the default header text for Invoice Approval.
4. Add a space and enter the following: <?call-template:InstructionText?>. By doing this, the custom instruction

text will be retrieved from the updated subtemplate and displayed in the workflow notification.
5. Save the file..
6. From the Analytics Publisher tab in the Ribbon, click HTML in the Preview group. If the preview reflects your

subtemplate changes as expected, then change the subtemplate path back to the location in the Custom folder,
for example: <?import:xdoxsl:///Custom/Templates/Workflow Notifications Subtemplate.xbs?>.

7. If you're not adding attributes to the report layout, close the file and skip to the Uploading the Modified Report
Layout task.

To add an attribute for Payment Terms in the header section of the report layout:

a. In your local copy of the report layout, select the Analytics Publisher tab.
b. In the Load Data section on the Analytics Publisher ribbon, click Sample XML.
c. On the XML data selection dialog box, select the .xml file that you saved in step 11 of 'Exporting the data

model' and click Open.
d. Click OK on the message that appears indicating that the data was successfully loaded.
e. Place your cursor in the Details section of the notification. Add an additional row after the Description

attribute.
f. In the Attribute column, enter a label for the new attribute. In this case, enter Payment Terms.

g. Then place the cursor in the Value column and go to the Analytics Publisher add-in. Navigate to Insert >
Field and search for Payment Terms in the search field.

h. Select the Payment Terms attribute and click Insert.
i. Save and close your copy of the report layout.
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Uploading the Modified Report Layout Template
To use the modified report layout template for future Invoice Approval Workflow Notifications:

1. Navigate back to the Oracle Analytics home page and click the Catalog link.
2. On the Catalog page, in the Folders section, expand Shared FoldersCustomFinancials Workflow

NotificationsPayables.
3. Select the Invoices folder to display the Data Models folder and the Invoice approval report.
4. Click the Edit link for the Invoice Approval Report to open the Invoice Approval Report page.
5. Click the View a list link to open the Layout page.

Note:  The Layout page displays the copy of the report layout template that was automatically created in step
5 of the Downloading the Report Layout Template task. Leave this report layout template as is. If the modified
workflow notifications don't work, you can revert back to using this report layout template, which is a copy of
the predefined report layout template.

6. Click the Create icon. A page opens with a Create Layout section and an Upload or Generate Layout section
7. In the Upload or Generate Layout section, click the Upload icon. The Upload Template File dialog box opens.

Complete with the following information:

Field Value

Layout Name
 

Enter a name for your modified report layout template. For example, enter Modified Invoice
Approval Template.
 

Template File
 

Click Browse. Locate and select the modified report layout template that's on your local drive.
Click Open to return to the Upload Template File dialog box.
 

Type
 

RTF Template
 

Locale
 

English
 

8. Click Upload. The Invoice Approval Report page returns to the thumbnail view of the report layout templates.
9. Click the View a list link to return to the Layout page with the list of the report layout templates

10. Select the row with the report layout template that you just uploaded and click the View Report button.
11. Review the modified report layout template.
12. To view the report layout template with sample data, enter values from an existing notification into the fields

and click Apply.
13. Repeat steps 1 through 5 to navigate back to the list of report layout templates. In the row for the report layout

template that you just uploaded, click the Default Layout option. This step enables the modified report layout
template for future Invoice approval workflow notifications.

14. Click the Save icon.

Related Topics
• Overview of Financials Configurable Workflow Notifications

• Configuring Payables Workflow Notifications
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4  General Ledger Reports

Considerations for Implementing Financial Reporting
Center  
The Financial Reporting Center adds self-service functionality for the Oracle Fusion Applications and the Oracle Fusion
Accounting Hub. The financial reports are available immediately on both computers and mobile devices, which leads to
quicker decision making.

Note:  To access the reports in Financial Reporting Center, store the reports in the My Folder or Shared Custom
directories.

Job Roles and Duty Roles
The following table shows the predefined job roles and their associated duty roles.

Predefined Job Role Duty Roles

General Accountant
 

• Financial Reporting Management

• Account Balances Review

General Accounting Manager
 

• Financial Reporting Management

• Account Balances Review

Financial Analyst
 

• Financial Reporting Management

• Account Balances Review

Business Process Model Information
The features are part of the Manage Financial Reporting and Analysis detailed business process.

The following table shows the activities and tasks for that business process.

Activity Task

Prepare Financial Reports
 

Generate Financial Statements
 

Analyze Financial Performance
 

Inquire and Analyze Balances
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Set Up Financial Reporting Center and Smart View  
Oracle Fusion Financial Reporting Center is a powerful tool for reviewing, designing, and presenting financial reports
and analytic data. The critical choices required to configure and install the components in Financial Reporting Center
consist of:

• Configuring the Financial Reporting Center

• Installing Smart View, performed by your end users

• Configuring Workspace Database Connection, performed by your administrator

Configuring Financial Reporting Center
You have access to the reports in the Financial Reporting Center and Workspace installed with Oracle Fusion Financial
Applications. Your Oracle Fusion Business Intelligence (BI) administrator defines the folder structure in Workspace. The
administrator considers your company's security requirements for folders and reports, as well as report distribution
requirements for financial reporting batches.

• Security can be set on folders and reports from Workspace.

• You are granted access to the folders and reports you want to view by your BI administrator.

Installing Smart View
Smart View is an Excel add-in that must be loaded on each client. To download Smart View, click Navigator  > Financial
Reporting Center > Tasks panel drawer > Open Workspace for Financial Reports. Once the workspace is started,
click  Tools > Install > Smart View.

Note:  Since Smart View is an add-in to Microsoft Office products, you can install Smart View only on a Windows
operating system.

Once Smart View is installed, you must configure the connection using the Smart View Shared Connections URL. You
can derive the Shared Connections URL by following these steps:

1. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.
2. Edit the workspace URL by removing index.jsp and adding SmartViewProviders at the end.

Note:  The following URL is an example for a Cloud-based environment. If the workspace URL is https://
efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/index.jsp, the Shared
Connections URL is https://efops-rel5st4-cdrm-external-bi.visioncorporation.com:10622/workspace/
SmartViewProviders.

3. Copy the URL.
4. Open Excel.
5. From the Smart View menu, click Options > Advanced.
6. Paste the URL in the Shared Connections URL field.
7. Click OK.
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To connect Oracle Fusion General Ledger Balances cubes in Smart View:

1. Open Smart View from your Start menu > Programs > Microsoft Office > Microsoft Excel 2007.
2. Navigate to the Smart View menu > Open. On the Start on the ribbon, click Smart View Panel that appears in

the list of values from the ribbon. The task pane opens.
3. Click Shared Connections on the task pane.
4. Sign in with your user name and password.
5. Click the  Select Server to proceed list of values.

Note:  If the Essbase Server isn't there, then it has to be added. Use the following steps:
a. Click the Add Essbase Server link.
b. Specify the Essbase Server login and password.
c. Expand the Essbase server and locate the cube in it.

6. Select Oracle Essbase from the list of shared connections.
7. Click the Expand to expand the list of cubes.
8. Expand your cube (name of your chart of accounts).
9. Click db.

10. Click the analysis link.

Note:  You must perform these steps only once for a new server and database.

To set how the name and alias of the Essbase database appears:

1. Click Options on the ribbon > select the Member Options > select Member Name Display.
2. Set one of these three options:

◦ Distinct Member Name. Only shows the full Essbase distinct path.

◦ Member Name and Alias: Shows both the member name and the alias.

◦ Member Name Only. Shows only the member name.

Note:  The Smart Slice feature isn't supported in Oracle Fusion General Ledger. For all other documentation, refer to
the Oracle Smart View for Office User's Guide.

Configuring Workspace Database Connections
Administrators must create database connections from Workspace so users can access the cubes from Workspace and
Financial Reporting Web Studio.

Note:  Ledger setup has to be completed before the database connection can be created. Oracle Fusion General
Ledger balances cubes are created as part of ledger setup. A separate cube is created for each combination of chart of
accounts and accounting calendar. A database connection is needed for each cube.

Steps to define a database connection are:

1. Start at the Navigator by selecting Financial Reporting Center.
2. From the Financial Reporting Center task panel, select Open Workspace for Financial Reporting.
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3. From within Workspace select the Navigator menu > Applications >BI Catalog.
4. Select Tools menu > Database Connection Manager.
5. Select New button.
6. Enter a user-friendly name for the Database Connection Name.
7. Enter Essbase as the Type, your server, user name, and password.
8. Select Application (cube) and Database from the list of values. Expand the Application name to see the

related Database.
9. Click the OK button twice to save your selections.

10. Click Close button in the Database Connection Manager window to save your connection.

Note:  The database connection is available in both Workspace and Financial Reporting Web Studio. Optionally, it
can be set up in Financial Reporting Web Studio when putting grids on a report. This should only be done by an
administrator.

For more detailed information about Smart View and Financial Reporting Web Studio, refer to the Using EPM with
Oracle Financials Cloud link on the Books for Oracle Financials Cloud page of the Oracle Help Center at https://
docs.oracle.com.

Smart View  

Overview of Smart View  
Oracle Hyperion Smart View provides common Word, PowerPoint, and Excel interfaces designed specifically for Oracle
Hyperion Enterprise Performance Management, Oracle Transactional Business Intelligence, and Oracle Fusion General
Ledger.

Using Smart View, you can view, import, manipulate, distribute, and share data in Excel, Word, and PowerPoint
interfaces. Smart View is a comprehensive tool for accessing and integrating Enterprise Performance Management,
Business Intelligence, and General Ledger content from Microsoft Office products.

Smart View provides the ability to create and refresh spreadsheets to use real-time account balances and activity. You
can use Smart View for:

• Analysis

• Predefined form interaction

• Report design

Analysis
Smart View uses the Excel environment to interactively investigate the data contained in the sources. You start with
templates that begin the process or a blank sheet where you begin shaping and altering the grids of data.

Predefined Form Interaction
As an Oracle Fusion user who executes predefined inputs or reporting forms, Smart View a convenient way of
completing tasks within Microsoft Office. Use Smart View to work in the Excel environment either for consistent
experience or to tie other spreadsheet-based models into your process. For example, use Smart View with Oracle
Hyperion Planning to incorporate data that is still housed in spreadsheet and workbook-based models.
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Report Design
Report design is another dimension of Smart View, which leverages the capabilities of Oracle Fusion General Ledger
data. Once the data is available within Smart View you can create reports as needed based on a combination of data
sources. For example, planning and financial management data can be used to compare actual to budget. Reports can
be made more complex by providing the ability to compare multiple scenarios for different periods. The power of Smart
View is used to create reports and is refreshed periodically, as needed.

Smart View provides the ability to create and refresh spreadsheets to use real-time account balance information. You
can use Smart View to:

• Perform ad hoc multidimensional pivot analysis with full spreadsheet functionality

• Drill down from any parent value to the next parent or child value

• Perform drill down from any child value to detail balances, journal lines, and subledger transactions

• Analyze actual, budget, and forecast information

• Increase visibility with charts and graphs

• Apply date effective hierarchies to past, present, or future hierarchies to change the financial data reported in
your financial reports. For example, to compare 2014 to 2015 results, realign the data in your 2014 reports by
applying the 2015 organization hierarchy.

Tip:  Best practice when using Smart View is to always turn on row suppression in the Smart View options. You can't
suppress columns in Smart View.  For more information about Smart View suppression, see the Smart View Options
chapter in the Oracle Smart View for Office User's Guide at http://docs.oracle.com/cloud/latest/epm-common/
SVPBC/opt_data.htm#SVPBC-options_202.

For more detailed information about Smart View, refer to the Using EPM with Oracle Financials Cloud link on the Books
for Oracle Financials Cloud page of the Oracle Help Center at https://docs.oracle.com.

Creating an Ad Hoc Analysis in Smart View  
This example shows how to create an ad hoc analysis in Smart View.

Creating an Ad Hoc Analysis
This example includes steps for configuring the Smart View connection, selecting dimension members, creating
separate reports, and formatting amounts.

1. Navigate to the Financial Reporting Center.
2. Open the Tasks panel and click the Open Workspace for Financial Reports task.
3. Remove /index.jsp from the end of the workspace URL and copy the rest of the URL. For example, copy

https://adc-fapXXXX-bi.oracledemos.com, where XXXX is the unique instance ID.
4. Open Excel.
5. Navigate to the Smart View ribbon and click Options.
6. In the Shared Connections URL field on the Advanced tab, replace everything before workspace with the

copied URL. For example, https://adc-fapXXXX-bi.oracledemos.com/workspace/SmartViewProviders
7. Click OK.
8. On the Smart View ribbon, click Panel. The Smart View panel opens.
9. On the Smart View panel, click Shared Connections.
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10. Sign in with your user name and password.
11. On the Smart View panel, select the drop-down list for the Select Server to proceed field.
12. Select Oracle@Essbase from the list of shared connections.
13. Expand the list of cubes for Essbase_FA_Cluster.
14. Expand the USChartofAccounts cube.
15. Select db. Don't expand the selection.
16. On the Smart View panel, click Connect, and then click Ad hoc analysis.
17. On the Essbase ribbon, click POV. The Point of View window enables you to select data dimension values, so

you can pinpoint the information you want for the Excel analysis.
18. On the Point of View window, click the drop-down list for each dimension and select the ellipsis (...) to open the

member selector. On the Member Selection window, remove the default selection for each dimension using
the Remove icon. Select the dimension value and add it using the Add icon. Click OK. Complete the member
selection, as shown in this table.

Field Value

Company
 

[All Company Values].[101]
 

Line of Business
 

10
 

Account
 

11200-Cash
 

Cost Center
 

All Cost Center Values
 

Product
 

All Product Values
 

Intercompany
 

All Intercompany Values
 

Scenario
 

Actual
 

Balance Amount
 

Period Activity
 

Amount Type
 

Period-to-date
 

Currency
 

USD
 

Currency Type
 

Total
 

19. On the worksheet, click the Accounting Period dimension in row 3, column A.
20. Right-click and select Smart View, Member Selection.
21. On the Member Selection window, remove the default selection. Expand the Accounting Period dimension

and add the period 12-16.
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22. Click OK.
23. Double-click Ledger in row 2, column B, to zoom in. You can also zoom in by selecting the dimension,

navigating to the Essbase ribbon, and clicking Zoom In
24. Click All Ledgers in row 2, column B, and click Zoom Out on the Essbase ribbon.
25. Right-click Ledger in row 2, column B, and select Smart View, Member Selection.
26. On the Member Selection window, remove the default selection of Ledger.
27. Select US Ledger Set and click the Add icon.
28. Click OK.
29. On the Point of View window, click Refresh.
30. Double-click US Ledger Set in row 2, column B, to zoom in.
31. Click the [US Ledger Set].[US Primary Ledger] cell.
32. On the Essbase ribbon, click Keep Only to remove the other Ledger members and keep only the selected

member.
33. To create a separate report based on the Company dimension, on the Essbase ribbon, click Cascade and select

Same Workbook. The Member Selection window opens.
34. On the Member Selection window, select [All Company Values].[102] and click the Add icon.
35. Click OK. A worksheet opens for company 102.
36. Click the All Company Values.101 worksheet.
37. Click the amount cell in row 3, column B.
38. Navigate to the Home ribbon and set the Accounting Number Format option to the dollar sign.
39. Navigate to the Essbase ribbon and click Preserve Format.
40. On the Point of View window, click Refresh.

Define a Report in Smart View with the Query Designer  
This example shows how to define a report using the Query Designer in Smart View.

Defining a Report with the Query Designer
1. Open Excel and navigate to the Smart View ribbon. Click Panel.
2. Click Shared Connections.
3. Sign in with your user name and password.
4. Click the Select Server to proceed drop-down list.
5. Select Oracle Essbase.
6. Expand the Essbase_FA_Cluster  and expand USChartofAccounts.
7. Highlight db. Don't expand db.
8. Click Connect.
9. Click the analysis link.

10. Navigate to the Essbase ribbon and click Point of View.
11. In the spreadsheet, click cell A2.
12. On the Essbase ribbon, click Query and select Query Designer. A new sheet named, Sheet1-Query is created

and the Query Designer displays.
13. On the Point of View panel, move:

a. Account to the Rows section.
b. Accounting Period to the Columns section.
c. Ledger to the Point of View section.
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d. Company to the Rows section, as the first dimension.

Note:  You can also select the dimensions cells on the worksheet and use the Pivot command on the Essbase
ribbon to perform these steps.

14. Open the Amount Type dimension by clicking the drop-down list and selecting the Member Selection link.
Remove the default placeholder using the Remove icon. Select the period-to-date value and add it to the panel
of selected values using the Add icon.

15. On the Member Selection window, click the drop-down list next to the Amount Type dimension to toggle to
each Point of View dimension. Complete the fields, as shown in this table.

Field Value

Ledger
 

US Ledger Set > [US Ledger Set].[Us Primary Ledger]
 

Line of Business
 

All Line of Business Values
 

Cost Center
 

All Cost Center Values
 

Product
 

All Product Values
 

Intercompany
 

All Intercompany Values
 

Scenario
 

Actual
 

Balance Amount
 

Period Activity
 

Currency
 

USD
 

Currency Type
 

Total
 

16. From the POV Sheet1-Query_1 panel, click AccountingPeriod to open the Member Selection window. You can
also open the Member Selection window from the worksheet by right-clicking the AccountingPeriod cell, and
selecting Smart View, Member Selection.

17. Remove the default selection. Expand 2016. Select all four quarters and add the quarters to the selected panel.
18. Click OK.

Note:  The four quarters become separate columns on the worksheet.

19. Click the Company dimension.
20. Expand All Company Values.
21. Select [All Company Values].[101] and [Company]@[941] and add them. Remove the default value.
22. Click OK.
23. On the POV Sheet1-Query_1 panel, click Account in the Rows section.
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24. Expand All Corporate Accounts-V1 > Account@[T] > 95001 - Net Income Current Year.
25. Expand 95011-Revenue and 95021-Expenses.
26. Remove the default value. Select the following values and add them to the selected panel:

◦ 95011-Revenue

◦ 40000-Revenues

◦ 95021-Expenses

◦ 50000-Material and Goods

◦ 60000-Operating Expenses

◦ 70000-Extra Charges and Tax

27. Click OK.
28. On the POV Sheet1-Query_1 panel, click Apply Query.
29. Save your report to the desktop as your initials Smart View Financial Report.
30. Insert 7 rows at the beginning of the spreadsheet.
31. Click in cell A3. Click the Insert tab and select Picture.
32. Select WINNT (D) > Labs > Fin_reporting > Vision Logo.
33. Click Refresh.

Note:  You must refresh periodically to maintain the connection to the database.

34. From the Insert tab, click Text Box.
35. Click cell C4 and type your initials Income Statement for Companies 101 and 941. Use excel formatting to

format the text however you want.
36. Click Refresh.
37. Click Save.
38. Highlight all the cells that contain amounts.
39. Navigate to the Home ribbon, and from the Number section, select dollar sign.
40. On the Home ribbon, in the Cells section, select Format > AutoFit Column Width.
41. Navigate to the Essbase ribbon and select Preserve Format.
42. Click Refresh.
43. Click Save.
44. Insert three rows between the data for company 101 and 941.
45. On the first new blank row in Column B, type Total Income.
46. Add the following formula for the first column with data Qtr1-14: =C10+C15 where C10 is 95001-Revenue and

C15 is 95021-Expenses.
47. Copy and paste that formula to the other columns.
48. Do the same formula for totals of Company 941.
49. Format all the total cells as Accounting. On the Essbase ribbon, select Preserve Format.
50. Click Save.
51. Insert 10 more rows between the data for Company 101 and 941.
52. Highlight all four rows of the expense data for all four quarters, including Material and Goods.
53. Navigate to the Insert ribbon and select the Line chart from the Chart section.
54. Select the first 2-D Line chart layout.
55. On the line chart, click the Legend that reads Series1, Series2, Series3, and Series4.
56. From the Chart Tools ribbon, select Select Data.
57. In the Legend Entries (Series) pane, select Series2 and click Remove. Series2 is a total of expenses and not

appropriate for this chart.
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58. In the Legend Entries (Series) pane, select each series individually and click Edit. Complete the series and
names fields, as shown in this table.

Series Name

Series1
 

Material and Goods
 

Series3
 

Operating Expenses
 

Series4
 

Extra Charges and Tax
 

59. In the Horizontal (Category) Axis Labels panel click the first one and click Edit.
60. Click the icon next to the Axis label range: field.
61. On the spreadsheet, highlight the four quarter headers and click the icon next to the Axis Labels field.
62. Click OK twice.
63. Move and resize the line chart to fit inside the blank lines.
64. Click Save.
65. Navigate to: Financial Reporting Center > Tasks panel tab > Open Workspace for Financial Reports.
66. Click Navigate > Applications > BI Catalog.
67. Expand Shared Folders > Custom > highlight Financial Reports.
68. From the Tasks panel, select Upload.
69. Click Browse and from your Desktop, select your Smart View Financial Report.
70. Click Open.
71. Click OK.
72. Close the EPM Workspace tab.
73. From the Financial Reporting Center, click the Search icon.
74. Enter Smart and click Search.

Note:  Your report may not be found immediately. Wait a few minutes and try again.

Create a Financial Report  

Define a Basic Financial Report Using the Reporting Web Studio  
This is the first of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

You can use Financial Reporting Web Studio to design traditional financial report formats such as balance sheets, profit
and loss statements, and cash flow reports. You can also design nontraditional reports for financial or analytic data that
include text and graphics.
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In this example, you're designing a basic financial report.

1. From the Financial Reporting Center work area, select the Tasks panel tab and click Open Workspace for
Financial Reports.

2. On the Tools menu, select Launch Financial Reporting Web Studio.
3. On the File menu, select New, Report.
4. On the toolbar, click the Grid icon. Grids are tables that contain data from external database connections.
5. In the design canvas, draw a box to create the grid. The Database Connection Properties dialog box opens.

Tip:  When creating a grid, best practice is to leave space in the design canvas for other objects, such as a
company logo and report title.

6. Select the Data Sources list and select the data source for the chart of accounts that the report is based on. A
unique cube exists for each combination of chart of accounts and accounting calendar.

Tip:  Best practice is to always turn on suppression in financial reports at the Database Connection Server
level. You can verify the setting by highlighting the grid, and then selecting Data Query Optimization
Settings on the Task menu. For most reports, best practice is to turn on suppression for the entire grid. Then
turn suppression off for columns and rows that must always display. For more information about suppression
settings, refer to the Defining Basic Conditional Suppression section in the Financial Reporting Web Studio
User's guide.

7. Click OK. The Dimension Layout dialog box opens.

Arrange the Dimensions
Use the Dimension Layout dialog box to arrange the dimensions on your report. For this report, the accounting periods
display on the columns and the revenue and expense account information displays on the rows. The company appears
on each page and can be selected at runtime.

1. Drag the Accounting Period dimension to the Columns axis.
2. Drag the Account dimension to the Rows axis.
3. Drag the Company dimension to the Page axis.
4. Click OK to close the Dimension Layout dialog box.

Define the Rows
Use the Select Members dialog box to define the revenue and expense account rows.

1. Select the revenue parent account.

a. Double-click the Account cell. The Select Members dialog box opens with a default member selected.
b. Remove the default Account selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
c. In the Search field, enter the value for the account that represents total revenue and click the Search

icon.
d. Select the account from the search results and click OK. The account moves to the Selected area.
e. Click OK. The Select Members dialog box closes.

2. Now insert a text row to add space between the revenue and expense accounts.

a. Select the last row in the grid by clicking the row header.
b. On the Insert menu, select Row, then Text.

3. Insert a row for the expense accounts.
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a. Right-click the last row header.
b. On the Insert Row menu, select Data. Notice the default value for the new row is the revenue parent

account.
4. Select the expense parent accounts.

a. Double-click the account value in the new expense account row. The Select Members dialog box opens
with the revenue parent account selected.

b. Remove the revenue parent account selection from the Selected area by clicking to select it and then
clicking the Remove from Selected icon.

c. In the Available area, expand the Account member, and continue expanding until you find the expense
parent accounts for the report.

d. Select the accounts and click the Add to Selected icon to move them to the Selected area.
e. Select the Place selections into separate rows option so each account appears in its own row on the

report.
f. Click OK. The Select Members dialog box closes.

Save and Preview the Report
Save the report and leave it open for the next topic, which is adding a formula to a financial report.

1. Click the Save icon.
2. Select the folder with your name and enter the report name and description.
3. Click Save.
4. Optionally preview the report in HTML or PDF format using the File menu or toolbar.

Add Formulas to a Financial Reporting Report  
This is the second of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a formula to summarize the expense account balances on your financial report.

Before you start, do the steps described in the Define a Basic Financial Report Using the Reporting Web Studio topic,
then follow these steps.

1. Right-click the last row header, select Insert Row and select Formula.
2. Click in the empty cell in the new row.
3. In the Heading Row Properties pane, select the Custom Heading option, enter Total Expenses and click the

Update icon. The new heading appears in the report.
4. Select the row header for the formula row. The SUM function appears in the design canvas.
5. In the Formula bar, click the Sum(0) button and enter the formula and cell references in the formula text box.

Because the expense rows appear one after the other, you can use the first row number and the last row
number with a colon in between. For example, Sum([3:5]). If the rows weren't contiguous, you could put
brackets around each row number and separate them with commas. For example, Sum([3], [5], [6]).

6. Validate the formula syntax by clicking the check mark icon in the toolbar. Validation checks the validity of the
formula, not if the data is available.

7. Save the report and leave it open for the next topic, which is defining a range function. Optionally preview the
report.

78

http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:28775
http://apex.oracle.com/pls/apex/f?p=44785:265:0::::P265_CONTENT_ID:28775


Oracle Financials Cloud
Creating Analytics and Reports for Financials

Chapter 4
General Ledger Reports

Define Range Functions for a Financial Reporting Report  
This is the third of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you define a range function to report across multiple accounting periods. You configure the range to
present balances for the last 12 months from the period selected at runtime.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report

Now follow these steps.

1. Double-click the Accounting Period cell. The Select Members dialog box opens.
2. Remove the default accounting period from the Selected area by clicking it to select it and then clicking the

Remove from Selected icon.
3. Click the Functions tab.
4. Select Range from the list.
5. Click the Add to Selected icon. The Range dialog box opens.
6. Define the starting member for the range.

a. On the Start Member row, click the Lookup Selection icon in the Value column.
b. Click the Functions tab.
c. Select the Relative Member function to define the periods that display on the report relative to the

period specified at runtime.
d. Click OK. The Relative Member dialog box opens.
e. On the Member row, click the Lookup Selection icon in the Value column.
f. Select Current Point of View for Accounting Period so you can enter the starting period for the report.

g. Click OK.
h. On the Offset row, enter -11 in the Value field.

The offset determines the first period of the range. The starting period in the range function is always
the oldest period. Because this is a rolling 12 period report, enter -11 to include the 11 periods prior to the
period you enter at runtime. The member selection for the End Member parameter determines period 12.

i. Click OK.
7. Define the ending member for the range.

a. On the End Member row, click the Lookup Selection icon in the Value column.
b. Select Current Point of View for Accounting Period.
c. Click OK.
d. Click OK to close the Range dialog box.
e. Click OK to close the Select Members dialog box.

8. Save the report and leave it open for the next topic, which is defining a grid point of view. Optionally preview
the report.
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Set User and Grid Points of View for a Financial Reporting Report  
This is the fourth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you set a user point of view and a grid point of view for a financial report.

All financial reporting reports have a user point of view and a grid point of view. Best practice is to use a combination of
both.

If you want users to select certain dimension members at runtime, then those dimensions should be set in the
user point of view. Selections for user point of view members are global for a user and data source. This means the
application saves and applies them to any other report that has the same dimensions set to the user point of view. By
default, all dimensions are set to the user point of view and must be selected at runtime. If you want your report to
always use certain dimension selections, then select the specific members in the grid point of view.

Note:  Members of a grid point of view only display in HTML.

In this example you set the Ledger, Scenario, Balance Amount and Currency dimensions to use the grid point of view.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report

Now follow these steps.

1. Select the cell in the grid that represents the intersection of the rows and columns. The Grid Properties pane
opens.

2. In the Grid Properties pane, click the Grid Point of View check box.
3. In the design canvas, click the Ledger: User Point of View for Ledger button. The Select Members dialog box

opens.
4. Expand the Ledger member and continue to expand until you find the ledger to include on the report. Select

the ledger.
5. Click Apply Selection.
6. Select Scenario from the Dimension list to select the type of balance to use on the report.
7. Expand the Scenario member and select Actual.
8. Click Apply Selection.
9. Select Balance Amount  from the Dimension list.

10. Expand the Balance Amount member and select Period Activity.
11. Click Apply Selection.
12. Select Currency from the Dimension list.
13. Search for USD.
14. Click OK to accept the search result.
15. Click Apply Selection.
16. Click OK to close the Select Members dialog box.
17. Save the report and leave it open for the next topic, which is setting page and grid properties. Optionally,

preview the report.
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Work with Grid Point of View Setup and Page Axis for a Financial
Reporting Report  
This is the fifth of six topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you change the grid point of view setup and set the page member selection to a prompt on your
financial report.

Before you start, do the tasks described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report

Now follow these steps.

1. Click the first cell in the grid to select all of the rows and columns.
2. Right-click and select Grid Point of View Setup from the list. The Setup Grid Point of View dialog box opens.

a. To prevent the Balance Amount dimension from being changed at runtime, select the Lock Member
Selection option.

b. Click OK. The Setup Grid Point of View window closes.
3. In the Grid Properties pane:

a. Click the Drill Through option to allow drilling from the report to the General Ledger transaction data.
b. Click the Suppression section to view the suppression settings.
c. Enter 0 in the Zero Values field to set the text option for rows with zero values. If necessary, you could

also suppress the display of rows with zero values, rows with missing data, and rows with errors.
4. Set a runtime prompt for the Company dimension so you have the flexibility of selecting any company or

combination of companies at runtime. In this example, you want to restrict the valid list of companies that can
be selected at runtime.

a. On the grid, click the Pages label. The Company dimension appears in the design canvas.
b. Click the Company button. The Select Members dialog box opens.
c. Remove the default Company selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
d. Select Prompt for Company.
e. Click the Add to Selected icon to move the selection to the Selected area.
f. Click OK. The Define Prompts dialog box opens.

g. Click the Lookup icon in the Choices List field. The Select Members dialog box opens.
h. Remove the default Company selection from the Selected area by clicking it to select it and then clicking

the Remove from Selected icon.
i. Expand the Company member, and continue expanding until you find and select the default companies

you want to display in the prompt.
j. Click the Add to Selected icon to move the companies to the Selected area.

k. Click OK. The Select Members window closes.
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l. On the Define Prompts dialog box, click in the Member Name field and select Alias. The actual company
label displays in the prompt list of values instead of a numeric company value, making the prompt more
user-friendly.

m. Click OK. The Define Prompts window closes.
5. Click the Pages label on the grid. The Page Properties pane opens.

a. In the Page Properties pane, select the Alias: Default option so each page of the report shows the name
of the company instead of the number.

6. Select the four data rows in the grid so all of the rows have the same settings.
a. In the Heading Row Properties pane, select the Alias: Default option in the Heading Row Properties pane

to display the revenue and expense account names instead of the accounts.
b. In the Heading Row Properties pane, select the Allow Expansion option so you can expand the parent

account values to view the detail child values.
7. Save the report and leave it open for the next topic, which is formatting your financial report and adding a

graph. Optionally, preview the report.

Add Formats and Graphs to a Financial Reporting Report  
This is the sixth and final topic in a series of topics on designing a financial report with Financial Reporting Web Studio.

Watch video
 

In this example, you add formats and graphs to a financial report.

Before you start, do the steps described in these topics.

1. Define a Basic Financial Report Using the Reporting Web Studio
2. Add Formulas to a Financial Reporting Report
3. Define Range Functions for a Financial Reporting Report
4. Set User and Grid Points of View for a Financial Reporting Report
5. Work with Grid Point of View Setup and Page Axis for a Financial Reporting Report

Now follow these steps.

1. In the report object browser, select the name of the report, which is the first object.
2. Add a logo.

a. In the report layout, drag the header line to make space for the logo and title.
b. In the Header section, click the Add Report Object icon and select Image.
c. In the Image Properties pane, click Browse and select your company logo.

3. Add a title.
a. Select the name of the report in the report object browser.
b. In the Header section, click the Add Report Object and select Text. As an alternative, you can click the

Text icon in the toolbar and draw the text box. The text box opens.
c. Enter the report title.
d. Select the title text and use the format toolbar to adjust the font size, center the text, and change the font

style to bold.
4. Change the page orientation.

a. Select the name of the report in the report object browser.
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b. On the File, menu, select Page Setup.
c. In the Page Setup dialog box, select the Landscape option.
d. Click OK.

5. Add a chart.

a. In the Body section, click the Add Report Object icon and select Chart.
b. In the Chart Properties pane, select the Line chart type.
c. To show only the expense account rows, deselect row 1, and select rows 3, 4, and 5 in the Data Range

section.
d. Click the Format Chart button. The Format Chart dialog box opens.
e. In the Appearance tab, enter the title for the chart. For example, Expenses by Period.
f. Click the Legend tab and enter a title for the legend. For example, Type of Expenses.

g. Click the Axes tab and enter a title for the Metadata axis. For example, Period. Enter a title for the
Primary Axis. For example, Dollars.

h. Click the Refresh Chart button to preview the chart on the Format Chart dialog box.
i. Click OK. The Format Chart dialog box closes.

6. Save the report and optionally, preview it.
For more information about Financial Reporting Web Studio, select the Using EPM with Oracle Financials Cloud link
from the All Books for Oracle Financials Cloud page of the Oracle Help Center at https://docs.oracle.com.

Configure an Account Group  
Configuration of an account group enables you to create self-monitoring accounts that help you eliminate the surprise
of account anomalies during your close process.

Scenario
You have been given the task to set up account groups. Follow these steps to define account groups that track key
account balances by purpose, category, and comparison criteria.

1. Navigate to the General Accounting Dashboard page.
2. In the Account Monitor section, select View > Account Group > Create. Other Account Group options include:

◦ Manage to create, edit, or delete account groups. You can also enable sharing of account groups with
other users.

◦ Edit to change an existing account group or to make a copy of an existing account group to which you
have access, whether it's an account group that you own, that's shared with you, or that's public. You're
marked as the owner of the copied account group, which is automatically set to private access, but can be
changed to the access setting that you like.

3. Enter the account group name and description. The name is used by default on the infolet that the account
group displays in, but can be changed using the infolet Actions menu.

4. Select a value for the Display In option to determine if the account group appears in one of the infolets
(Allocations, Expenses, Revenues), the Account Monitor, or the Close Monitor. The display option that
you select can affect the other account group settings. For example, account groups that display in the
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Close Monitor must have public access, and account groups that display in infolets must have the option to
dynamically derive the ledger enabled.

Note:  Regardless of its display setting, any account group can be viewed from within the Account Monitor
and Financial Reporting Center.

5. For each infolet and Account Monitor display setting, you can specify a default account group by selecting the
Set as default option. The default account group setting is user-specific, determining which account groups
appear to you when you view the infolets and the Account Monitor.

Note:  The default setting doesn't affect account groups that are set to display in the Close Monitor. The
account group that displays in the Close Monitor is determined by the ledger set definition.

6. Select the Dynamically derive ledger option to apply the account group to any ledger in the same balances
cube. The ledger derived is based on your given data access set selection. You must enable this option for
account groups that display in the Revenues, Expenses, and Allocations infolets.

Note:  If you don't select this option, enter a ledger on each account row.

7. Select a Time Option and Comparison Option as shown in the following table.

Time Option Comparison Option

Accounting Period
 

◦ Budget PTD

◦ Budget QTD

◦ Budget YTD

◦ Prior period PTD

◦ Prior year PTD

◦ Prior year QTD

◦ Prior year YTD

Quarter
 

◦ Budget QTD

◦ Budget YTD

◦ Prior quarter QTD

◦ Prior year QTD

◦ Prior year YTD

Year
 

◦ Budget YTD

◦ Prior year YTD

Tip:  If you're using a budget comparison option, select the budget name in the Scenario field.

8. Set the access.

Note:  Regardless of the access setting, only the person who owns the account group can modify it. However,
for account groups that you have access to, you can share with others even if you're not the owner.

◦ Private: For your use only.
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◦ Public: For use by all users who have access to the same balance cube of that account group. Account
groups that display in the Close Monitor must be set to Public.

◦ Shared: For use by users you specify and who have access to the same balance cube of that account
group.

Note:  To set shared access, navigate to the Manage Account Group page.

9. In the Accounts section, enter the accounts to monitor. The accounts must be defined to be consistent with the
particular infolets targeted to track revenues, expenses, or allocations pools.

◦ Accounts included in an account group for display in the Expenses infolet must be of the account type
Expense.

◦ Accounts included in an account group for display in the Revenues infolet must be of the account type
Revenue.

◦ Close Monitor account groups must only have two account rows. The first row must represent total
revenues and the second row must represent total expenses.

a. Give each account a short name that's easily recognizable. The name displays in infolets and in the Name
column of the Account Monitor. For account groups that display in infolets, you must provide a name for
each account.

b. If the Dynamically Derive Ledger option isn't enabled, you must enter a ledger.
c. Enter either parent or child values for each segment of the account.
d. Select when to display the account in the Change field.

- Always Display
- Decrease by Less than Amount
- Decrease by Less than Percentage
- Decrease by More than Amount
- Increase by More than Amount
- Increase by Less than Amount
- Increase by Less than Percentage
- Increase by More than Percentage
- Decrease by More than Percentage
- Not Equal
- Equal

e. Enter a value in the Threshold field, which is the criteria that's being measured against. The threshold is
used in conjunction with the Change field selection.

10. Click Save and Close or Save and Create Another.

Related Topics
• Account Groups
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FAQs  

How can I apply permissions to objects from Financial Reporting in
Workspace?  
Open the Permission dialog box from the Tasks list to set permissions for a catalog object.

Permissions determine which user, group, or role can view, open, or modify the object. If you display this dialog box
while working in the catalog in Workspace, any permission changes that you specify are applied immediately. If you
display this dialog box as part of the Batch Scheduler wizard, then the permission changes are not applied until you run
the batch.

How can I store and edit Financial Reporting objects?  
First install Oracle BI EE as part of Oracle Fusion Applications. Then store and edit new objects that you create for Oracle
Hyperion Financial Reporting in Workspace in the Oracle BI Presentation Catalog.

Perform operations on those objects in the catalog similarly to how you work with other objects, such as copying and
modifying properties. See the documentation for Hyperion Financial Reporting for complete information on working
with objects. Financial Reporting report designers can also access the Financial Reporting objects in the Financial
Reporting Web Studio.

How can I migrate Financial Reports from one environment to
another?  
You can export your financial reports from a source environment and import them to a target environment using
implementation projects.

Only the financial reports in the /shared/Custom/Financials folder are exported, so make sure to copy all the
financial reports, or the folders containing them, to this folder. In the Setup and Maintenance work area, create an
implementation project that includes only the Create Financial Statements task. Then use the Manage Configuration
Packages task to export and import the reports.

Note:  For the Financial Reporting report definition migration service, from a source to a target environment,
references to version IDs of dimension members hierarchies are synchronized to their version IDs in the target
environment.
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Related Topics
• How You Use Implementation Projects to Manage Setup

• Setup Data Export and Import Using Implementation Project

• Export Setup Data Using Implementation Project

• Import Setup Data Using Implementation Project
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